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Access Manager Module Settings and
Operation Guide

List of terms used in the Access Manager Module Settings
and Operation Guide

User - a person whose data are processing by the Access Manager module. The Access Manager module allows processing
data of visitors, vehicles and other types of users. Configuring and working of the module with different types of users are
the same. In case of configuring and working with specific functions it will be additionally specified.

Operator - a person who configures and operates with the Access Manager module.

APB (Antipassback) — a control over access order. Function allows protecting from repeated use of identifier to pass in one
direction.

Holiday - a non-working day. Specifying of holydays list in the system allows eliminating of defined days from time zones.

Access point — a point where access control is performed. An access point may be a door, a turnstile, a gate, or a boom
barrier equipped with a reader, an electromechanical lock, or other access control devices.

Access level - right of user to access through the access point (points) depending on the time schedule. Also defines rule
of arming and disarming access point. Access level can be general for all users from department and separate for one,
several or all users.

Control reader - a reader which is used for card input to system.

Access Manager Module Settings and Operation Guide.
Introduction

On the page:

® Purpose of the document
® General information about the Access
Manager module

Purpose of the document

The Access Manager Module Settings and Operation Guide is a reference manual designed for Access Manager module
configuration technicians and operators. This module is part of the ACFA Intellect software system.

This Guide presents the following materials:

1. general information about the Access Manager module;
2. Access Manager module settings;
3. working with the Access Manager module.

General information about the Access Manager module

The Access Manager software module is a component of the ACFA Intellect software package and supports the following
actions:

configure access mode of users and visitors to object with automated access control systems;
configure movement rules of users and visitors within object according to access levels;
configure operator rights to create, edit, delete and view departments;

configure operator rights to create, edit and delete access levels and users;

create and configure access levels as for each user and for all department;

create, configure and delete accounts of users and departments;

create, configure and delete time schedules and access levels;

print security passes for users.

Configuration of the Access Manager module
Procedure of configuring the Access Manager module

N RAWNE

The Access manager module is configured on the settings panel of the Access manager object and on settings panels of
the User rights in Access Manager and Type of department sub-objects. The Access manager object is created on
basis of the Display object on the Interfaces tab of the System settings dialog window.
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The Access Manager module is configured as follows:

Configuring of location the Access manager window on the screen.

Specifying rights to configure objects in the Access manager window: visibility of departments, access rights for
configuring access levels, users and departments.

Configuring of using control readers.

Select available cameras for input of user photos.

Configuring parameters of user creation.

. Configuring of fields displaying.

N =
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Configuring the position of the Access manager window on the

screen

Position of the Access manager window is not fixed on the screen on default and it can be changed. If it's required to

specify position of the Access manager window on the screen eliminating possibility to change its position, do the

following:

Note. When specify the fix position of the Access manager window on the screen, the caption bar won't display which
increase the displaying area of the Access manager window content.

1. Go to the settings panel of the Access manager object.

Departrents | Readers I Cameras | Dther$|

1 Acceszs Manager 1
: : =] Al departments
Dizplay || Disable L[] Department 1
| Display 1 [¥] Departmert 2
Department 3
Position [¥] Department 4
[] Fix position | 1 Departrient 5
Manitar 1 2 ‘- [¥ Department &
s 50 i 50 3
W ] H: 500 4
Access levels settings
Create
| Edit
Delete :
|Jzer zettings
Create

Delete Edit
[] Create users with APB

Departments settings

Create
] Edit

Delete
Mew departments are vizible in root

. Set the Fix position checkbox (1).

. From the Monitor drop-down list select a system monitor on which the Access Manager window is to be displayed
(2).

. Set coordinates of the Access Manager window's upper left corner in the X: and Y: fields as percentage of width
and height of the screen correspondingly (3).

. Set width and height of the Access Manager window in the W: and H: fields as percentage of width and height of
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the screen correspondingly (4).
6. Click the Apply button (5).

Specifying fix position of the Access Manager window on the screen is completed.

Rights for configuring objects in the Access Manager

General information about rights for objects configuring in the Access
Manager
Specifying rights for objects configuring allows to restrict actions available for operator of the Access Manager module while

departments configuring, users and their access levels. Rights for objects configuring definitely correspond to user rights in
the ACFA Intellect software package.

Rights for objects configuring in the Access Manager include permission or forbidding to perform the following operations
with access levels, users and departments from the Access Manager window:

1. Create.
2. Edit.
3. Delete.

(D Note

Visibility for departments is also configured in the Access Manager module.

All operations mentioned above are allowable for operator.
The Access manager software module allows specifying of common and individual rights for objects configuring.

Common rights for objects configuring have priority over individual rights. So if performing of some operation is forbidden
by common rights for objects configuring, than it will be forbidden for all operators, even if it will be permitted by some
individual rights.

Common rights for objects configuring are specified on the settings panel of the Access Manager object.

Intefaces

Programming

1 Access Manager 1 Departments | Readers | Cameras | Others

E-C] 40 departmerts

- Display 1 [1] Display || Disable Depattrment 1
| Diizplay 1
A, Operators” permissions F‘Dsi.tinn -
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Individual rights for objects configuring are specified on the settings panel of the User rights in Access Manager object,
which is created on the basis of the Access Manager object on the Interfaces tab of the System settings dialog
window.



B-@ Display 1 [1]
L.[E] Monitor1 [1]

Access Manager] [1]

Operators” permissions

Operators” permissions in AM1.2 [12].
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Operators" permissions in Ak ©

Access Manager Dizable

‘ Access Manager 1

Uszer rights

[ Usger permissions 1 -

Access levels settings

Departments | Standard fields I Additional f\elds|

Department 4
Department 5
Department &

-8 Types of departments Create Edit
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Specify correspondence of operator rights in the Access Manager and in
the Intellect software package

Individual rights for objects configuring in the Access Manager definitely correspond to user rights in the ACFA Intellect soft
ware package. So only one User rights in Access Manager object can correspond to one User permissions object and
vice versa.

0)

Note

If similar operator rights in the Access Manager should correspond to user rights in the ACFA Intellect software
package, use the Save function from context menu of interface object, see The Save function section of

the Intellect software package. Administrator's Guide.

To specify correspondence of operator rights in the Access Manager and in the ACFA Intellect software package, do the
following:

1. Go to the settings panel of the User rights in Access Manager object.
2. From the User rights drop-down list select the User permissions object which is required to match to the User
rights in Access Manager object (1).

Departments | Standard fislds | Additianal fields
E||:| All departrments

1.2 Operators” permizzions in Ak -

Access Manager Dizable Department 1
|.-‘-'«c:c:ess tanager 1 ¥ Department 2

[¥] Department 3
Llzer rights 1 Departrent 4

[¥] Department 5

[Llser peEmizzions 1 H
i.[J] Department &

Access levels settings

Create Edit
Delete

Uzer zettings

Create Edit
Delete

Mew departments are vizible in root

(D Note

User permissions objects are created on the Programming tab of the System settings dialog window.
Creating and configuring of these objects is described in the Rights administration section of the Intellect
software package. Administrator's Guide. The current version of this document is available in the
documentation repository
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3. Click the Apply button (2).

Specifying correspondence of operator rights in the Access manager and in the ACFA Intellect software package is
completed.

Rights for configuring access levels in the Access manager

To specify common and individual rights for configuring access levels, do the following:

1. Go to the settings panel of the Access Manager or User rights in Access Manager object.
Aocess levels zettingz

] ey
2[omee] LERDS

2. Ifit's required to forbid operators to create access levels, remove the Create checkbox in the Access levels
settings group (1).

3. Ifit's required to forbid operators to delete access levels, remove the Delete checkbox in the Access levels
settings group (2)

4. If it's required to forbid operators to edit access levels, remove the Edit checkbox in the Access levels settings gr
oup (3).

Specifying of common and individual rights for configuring access levels is completed.
Rights for users configuring in the Access Manager
To specify common or individual rights for users configuring, do the following:

1. Go to the settings panel of the Access manager or User rights in Access Manager object.

Uzer zettingz
1[2Creae]
21v Deletel 3

A| | Create uzers with &4PE |

If it's required to forbid operators to create users, remove the Create checkbox in the User settings group (1).

If it's required to forbid operators to edit users, remove the Edit checkbox in the User settings group (2).

If it's required to forbid operators to delete users, remove the Delete checkbox in the User settings group (3).

If it's required to allow operators to create users with antipassback enabled, set the Create users with APB check
box in the User settings group (4).

(D Note

Create users with APB checkbox is available only on the Access manager settings panel.

uhown

Specifying of common and individual rights for users configuring is completed.
Rights for configuring and viewing departments in the Access Manager
To specify common or individual rights for configuring and viewing departments, do the following:

1. Go to the settings panel of the Access manager or User rights in Access Manager object and open the Depart
ments tab (1).
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[ f| Departrment 3
Pozition

<\ Departrment 4
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| Create | Edit

| Delete 2
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Set checkboxes close to departments which should be available in the Access Manager interface module (2).

If it's required to forbid operators to create new departments, remove the Create checkbox (3).

If it's required to forbid operators to edit departments, remove the Edit checkbox (4).

If it's required to forbid operators to delete departments, remove the Delete checkbox (5).

New departments located in the root of departments hierarchy and departments replacing to the hierarchy root. On
default new departments locating in the root of departments hierarchy and departments transferred to the root of
hierarchy regardless of their visibility before transferring are available in the Access Manager interface window - the
New departments are visible in root checkbox is set (6). If new departments and departments transferred to
the root of hierarchy should be invisible in the Access Manager window, deselect the checkbox.

Attention!

If the New departments are visible in root checkbox is deselected, creation of new departments in the root of
departments hierarchy will be forbidden even if the Create checkbox is set (3).

Note

New departments created via the Access Manager module on the basis of visible departments will be visible on
default.

Specifying of common and individual rights for configuring and viewing departments is completed.

Configuring readers in the Access Manager



Selecting control readers in the Access Manager

It is possible to specify the list of control readers used for assigning access cards to users in the Access Manager interface
window while configuring the Access Manager program module.

To select control readers, do the following:

1. Go to the settings panel of the Access Manager object.
2. Go to the Readers tab (1).

| Departmen"@l Readers |Eameras | Dthers|

| 1 Access Manager 1
= !
Confirm card entered by operator
F580 control reader 1 I_
Fozitian p—— e |7
Fix pasition e Parking access point
b anitar | 1 . | (Gate Parking access point 2 |7
iohini v
s v Suprema BioMini 1 F2
w 4

Access levels settings

| Creat
. reate Edit

Delete

|zer zettings

Create i
Delete Edit

Create users with APE

Departments settings

Create
] Edit

Delete
Mew departments are visible in oot

3. Set checkboxes close to those readers which should be available in the Access Manager window while access
cards input (2).

Note
Objects corresponding to control readers are created and configured on the Hardware tab of the System
settings dialog window (see Control Readers Settings Guide)

4. To save changes click the Apply button (3).
Selecting of readers is completed.
Configuring confirmation of access cards input in the Access Manager
If it's required that operator confirms assigning of access cards to user, do the following:

1. Go to the settings panel of the Access Manager object.
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Fozition
Fix position
b anitor l1 v]
w v
Access levels settings
Create
W Edit
Delete :
|Jzer settings
Create _
Delete Edit
Create uzers with AFB
Departments sethings
Create SN
[elete =

Mew departrments are vizible in root

| Depaltmen‘lsl Readers |Eameras | Dthets|

Confirm card entered by operatar I 2

F580 control reader1

Gate Parking access point 1 F
Gate Parking access point 2 F
Suprema BioMini 1 F

2. Go to the Readers tab (1).

3. Set the Confirm card entered by operator checkbox (2).
4. To save changes click the Apply button (3).

Configuring of confirmation access cards input is completed.

Selecting available cameras in the Access Manager

To select available cameras, do the following:

1. Go to the settings panel of the Access Manager object.

Pogition

Fix: pozition
b onitar [1 v]
K Y.
w .
Access levels settings
Create
| Edit
Delets !
& Iser settings
Create .
Delete Edit

Create uzers with 4FB

Departments settings

Create = :
Delete el

MHew departments are wizible in root

| Depaltmentsl Headetsl Cameras |D1her8|

The Access Manager program module allows specifying cameras which will be available in the Access Manager window for
setting photos to users.

Cameras Use Gateway
Carmneral I7 Videogate 1
Camera 2 F

Camera 3 |_

2. Go to the Cameras tab (1).

3. In the Use column set checkboxes close to cameras which are to be used for setting photos to users (2).

(D Note
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Camera objects are created on the Hardware tab of the System settings dialog window. Creating and
configuring Camera is described in the Intellect software package. Installing and Configuring Security
System Components Guide document. Current version of this document is available in the documentation
repository.

4. If video from camera is to be received using videogate, select the required Videogate object from the drop-down
list in the Gateway column (3).

@ Note

The corresponding Videogate object should be configured for data transferring with this camera.
Configuring the Videogate object is described in the Intellect software package. Administrator's guide doc
ument. Current version of this document is available in the documentation repository.

5. To save changes click the Apply button (4).
Selecting of available cameras is completed.
Configuring parameters of users creation in the Access Manager
To configure parameters of users creation, do the following:

1. Go to the settings panel of the Access Manager object and switch to the Others tab (1).

1 ticoess Manager 1 Departments I Readers | Eamerasl Others I 1
Criteria of uzer parameters duplicates
Dizplay [ | Dizable
. Full Mame [Surname, harme vl | 2
Diizplay 1
Extemal 1D 3
Pasitian Wehicle license plate [+ 4
[ | Fix position
tonitor 1
W A0 H: 0
Access levels settings
Create
7] E dit
Delete
Uzer settings
Create _
Delete Edit
|| Create users with &PE
Departments settings
Create
71 Edi
Delete Edit
Mew departments are vizsible in root todule version 10711
Apply Cancel

2. From the Full Name drop-down list select the way of definition duplicate user records (2):
a. Not used - it's accepted to add users with equal full name.
b. Surname, name - it's forbidden to add users with equal name and surname even if patronymic is differed.
c. Surname, name, patronymic - it's forbidden to create users with equal full name.

3. Set the External ID checkbox if you want to forbid creating users with the same external identifiers (3).

4. Set the Vehicle license plate checkbox if you want to forbid creating users with the same vehicle plate numbers (

4).
5. To save changes click the Apply button (5).

Configuring parameters of users creation is completed.
Configuring fields displaying in user accounts
Configuring a type of department in the Access Manager

Type of department defines fields of users available to view and edit in the Access Manager interface window.

Default department type (Main), in which all main fields are available for editing and additional fields are hidden, will be
available in the Access Manager window if department types are not created.

.[:D Note

Visibility of fields is defined by operator rights - see the Configuring availability of fields depending on operator
rights in the Access Manager section.

Type of department is configured on the settings panel of the Type of department object which is created on the basis of
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the Access Manager object on the Interfaces tab of the System settings dialog window.

Interfaces Programming

|1 A |Type of department 1.1 lcon | lcon @ j
(@) Display 1 Access Mahager I~ Disable Template j
[ ASS anagr 1 ) |Access Manager 1 - Apply
upes of d ments
! Standard fieds | Addional ks |
-, "Users ngnts
e Map 1 Name of field | Category =
] moritor 1 Sumare Edit 0. Full name
Name Edit 0. Full name
Patronymic Edit 0. Full name
Personnel number Hidden 1. Personal data o
External ID Edit 1. Personal data
Position Edit 1. Personal data
Date of hiring: Edit 1. Personal data
Date of firing Edit 1. Personal data
Temporary AL activation date Hidden 1. Personal data
Temporary AL expiry date Hidden 1. Personal data
Access cards Edit 1. Personal data
Coarnmencamant of card Edit 1 Dercnnal data hd|

To configure type of department, do the following:

1. Go to the settings panel of the Type of department object.
2. From the Icon drop-down list select the icon for displaying of department in the Access Manager window (1).

1.1 |Type of depastment 1.1 1| 1con|lcon 0 -
Access Manager I™ Dizable 3| Template |Employees =|

Access Manager 1 i 4 | Apply |
Standard felds | addiional felds | |5

Name of field Category =
Surname Edit 0. Full name

Name Edit 0. Full name

Patronymic Edit 0. Full name

Personnel number Hidden 1. Personal data

External ID Edit 1. Personal data

Position Edit 1. Personal data

Date of hiring: Edit 1. Personal data

Date of firing Edit 1. Personal data

Temporary AL activation date Hidden 1. Personal data

Temporary AL expiry date Hidden 1. Personal data

Access cards Edit 1. Personal data

Cammenramsnt of card 2 Frlit 1 Parcanal dats :l

Ppply Cancel

3. List of available fields is displayed in the Name of field column (2).

Note
See description of fields in the Setting user parameters section.

4. It is possible to select template types of departments while going from the Visitor Management System module to
the Access manager module and for convenience of settings of general fields availability. To perform it, do the
following:

a. From the Template drop-down list select the required template of department type (3). Templates of
following department types are available: Employees, Visitors, Vehicle.

b. Click the Apply button to apply the template (4). As a result values in correspondence with the selected
template will be displayed in the Standard fields and Additional fields tabs (5).

1 Attention!
Settings of the Type of department object won't be saved while clicking the Apply button. This
button only changes values of fields to the specified values in the template. To save these settings
click the Apply button when all settings will be completed (see step 6).

5. If it's required to set visibility and availability for required fields editing manually, do the following:
a. In the column (6) from the drop-down list select one of the following values:
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Value Description
Hidden The field is not displayed in the list of user parameters while viewing and editing

Read The field is displayed in the list of user parameters while viewing and editing but is not available
only for editing

Edit The field is displayed in the list of user parameters while viewing and editing and is available for
editing.

Note. It is not available to edit Card issued by and Access level assigned by fields because
these fields are filled in automatically by the operator data while changing/assigning access level
or access card.

b. In the Category column enter the name of group in which the field will be displayed in the list of users
parameters in the Access Manager window while editing and viewing (7). Category name can be optional.
If category is not specified, the field will be displayed in the Other category of the list of parameters.

(D Note

Categories in the list are sorted by alphabet. If it's required to strictly define the order of
categories, use numeral prefix as for categories used in templates (see step 4).

6. To save changes click the Apply button (8).

Configuring of department type is completed.
Configuring availability of fields depending on operator rights in the
Access Manager

The Access Manager program module allows restricting of visibility and availability for editing user fields depending on
operator rights in the Access Manager. Prohibition on performing operation with field in operator rights has priority over
availability of field for viewing and editing specified while configuring the type of department. For example, if some field is
available for editing in accordance to settings of department type, but its review is forbidden by rights of some operator,
than this field won't be visible to this operator. Conversely, if editing of field is allowed by operator rights in the Access
manager but the field is available only for reading, than the field will be available for reading for all operators.

@ Note

User reregistration in the ACFA Intellect software is required to apply changes when rights of the current operator
are changed.

To configure availability of fields depending on operator rights, do the following:

1. Go to the settings panel of the User rights in Access Manager object.

i1 [User rights in Access Manager Departments| Standard fiekds | Addiions fieids |1 =
: Name of field =
@H e IR Surname Hidden
 hcoess Manager 1 " | Name Hidden
User rights Patronymic Hidden
ILIser permissions 1 ﬂ Personnel number Hidden
- Access levels selings— | External ID Hidden
¥ Create ¥ Edi Position Hidden
¥ Delete Date of hiring: Hidden
Lisas saltinge ~ | Date of firing Hidden I
¥ Create ¥ Edit Temporary AL activation date Hidden
¥ Delete Temporary AL expiry date Hidden
Access cards Hidden
Commencement of card Hidden
Card expiry date Hidden
Date of card issue Hidden
MNumber of card loss Hidden
PIN code Hidden
| Access levels Hidden ~|
¥ MNew departments are visible in oot 2

- I _—————————————

2. The list of all user fields is displayed on the Standard fields and Additional fields tabs (1). All user fields are
hidden on default.

i
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* Note
See also description of fields in the Setting user parameters section.

3. In the column (2) from the drop-down list select one of the following values:

Value Description
Hidden The field is not displayed in the list of user parameters while viewing and editing

Read The field is displayed in the list of user parameters while viewing and editing but is not available for
only editing

Edit The field is displayed in the list of user parameters while viewing and editing and is available for
editing.

Note. It is not available to edit Card issued by and Access level assigned by fields because these

fields are filled in automatically by the operator data while changing/assigning access level or access
card.

4. To save changes click the Apply button (3).
Configuring of availability fields depending on operator rights is completed.

Access Manager module interface

General view of the Access manager interface window is shown in the figure.

<7 Access Managerl EI@
-
[ o]

@ Time zones
= Depatment Employees

> ) -~ ) Usercad
- g Department Account Management
g Department Administration T L I
2 pepornent osowoter o O ([

Departments

o) =
n Access levels ‘\- Regions and areas

Foreman Susan Major Major Access level  Comment
"Never" Inherited
- Smith Anna (2)
Smith John Basic
Al |
F=_| Z
4 0. Full name -
Mame Anna M
Patrorymic ‘

Sumame Smith
4 1. Personal data
Access level
Antipasshact No
Card expiry d Not specified

m

e L
Date of card 6/27/2016 2:00:2
Access level "Newver" Date of fiing Mot specified
Extemal 1D Date of hiring 6/27/2016 2:00:%
D 3 Exdemal ID
Mame Department Caseworkers MNumber of cz 0
Type of department  Main Office phone
Users 4 Origin
Passport nun
Personnel nu o
DIk| s

(D Note

If fix position of the window in the screen is specified, the name of the Access Manager window won't be displayed
- see the Configuring the position of the Access manager window on the screen section.

The Access Manager window contains three tabs:

Departments tab
Time zones tab
Access levels tab
Regions and areas tab

AWNR

Description of each tab is follows.

Departments tab

Working with departments and users is performed on the Departments tab.
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25 Access Manager1

q n
o Departments EB Time zones | v | Access levels Regions and areas‘ 4] 7
El :.. Department Employees H H User card
-2 Department Account Management
- o Department Administration I I
¢ e Department Caseworkers - ‘
" g Department Visitors Foreman Susan Major Major Smith Anna Access level  Comment
1 8 "Mever” Inherted
‘ 4] I Foreman Susan {3)'
Smith John | Addiionsl
5 4 0. Full name: -
Name Susan |
Patrorymic
Sumame Foreman
4 1. Perzonal data E |
Access level I
Artipassbact No
3 4 1 u Card expiry d Mot specified
- Card issued i |
2 Q Date of card 6/27/2016 2:01:0
Access level "MNever" Date of fiing Mot specified
Edemal 1D Date of hiring 6/27,/2016 2:01:C
D 3 Bdemal ID
Mame Department Caseworkers Number of cz 0
Type of departmert ~ Main Office phone
|Users 4 Crigin

Passport nun

Persannel nu
DIk s

Description of Departments tab elements is given in the table.

Ne

1

10

Element

Departments
tree

Department
parameters

Search for
department

Add
department

List of
department
users

List of user
access cards

User photo
List of user
access levels
User full

name

User
parameters

Description

Hierarchy structure of created departments available for viewing relying on operator rights and/or
settings of the Access Manager object — see the Rights for configuring and viewing departments in

the Access Manager section.

Parameters of department: ID, External ID, Name, Number of users, Type of department, Access

levels.

Setting and editing of department parameters is given in the Working with departments in the Access

Manager software module section.

Department search button - see the Department search section.

Button of adding a department —-see the Adding a department section.

List of users from the selected department.

Displaying of the list of access cards assigned to user. See also the Assigning an access card to a
user section. This list can be hidden or is not available depending on the Access card settings in
operator rights and/or on the Access manager object (see the Configuring fields displaying in user

accounts section)

Displaying of photo assigned to user. See also the Assigning a photograph to a user section.

List of access levels assigned to user. See also the Assigning access levels to a user section. This list
can be hidden or is not available depending on the Access levels settings in operator rights and/or
on the Access Manager object (see the Configuring fields displaying in user accounts section)

Displaying of user surname, name, patronymic and its ID (in brackets).

Displaying of user information. Description of fields is given in the Setting user parameters section.




Time zones tab

Working with time zones and holidays is performed on the Time zones tab.

¢; Access Manager 1 I. = | (=] |_ihj
- AT | ) =
an Departmerrtsﬂ h__'j Time zones n Access levels - Fegions and areas
MName | MNumber [[ Time fone 1 (1D 1)
= Time Zone 1 1 interval | Mon | Tue | Wed | Thu | Fi | Sat | Sun | Holiday
= Time Zone 2 2 03001800 + + + o+ o+

1 2

3

l Holiday editor
—

LS

Description of Time zones tab elements is given in the table.

N2 Element Description

1 List of Names and identification numbers of time zones created in the system. The following ways of displaying
time time zones list are available: List, Table, Large icons. The Table view is used on default. See also the
zones Selecting a view of displaying objects list in the Access Manager section.

2 Time List of intervals incoming to the time zone.
zone
intervals

3  Holiday Button opening a window of holiday editing - see the Editing holidays section.
editor

Access levels tab

Working with user access levels is performed on the Access levels tab.
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22 Access Manager 1 IEI@M
il

-~ [ =
I @ Departments @ﬂmemn&a () Accesslevels Hj Regions and areas

o Access level 1
- Access level 2
== Mew folder
1
| a Accesslevel 3
Access level 1({ID 1) 2
Access point ] Time zone Am Disam Load
{Bio Smartmini 1.7.1 1.1.1 Time zone "Aways" + + +

Description of Access levels tab elements is given in the table.

N2 Elements Description

1 List of List of access levels created in the system. The List view is used on default. See also the Selecting a
access view of displaying objects list in the Access Manager section. For details on working with the elements
levels of the list, see Managing the list of access levels.

2 Access Description of selected access level: list of access points with identification numbers and time zones,
level parameters of access point arming and disarming, sending access cards to controller after presenting

parameters access card by user. The Table view is used by default.

Regions and areas tab

The Regions and areas tab allows to perform Emergency Monitoring.
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CF Access Manager 1

~
- Departments

=N
Y "j Time zones

y ;
Fegions and areas

mn
n Access levels

B--é Mew area

‘wiorking area

1

User card

[127)12345
[205) 34567

-
a

Smith John Patric

Access level  Comment

_ 6
Srith J ohin Patric: (11 7

Basic | Additional 8

L

4 0. Full name -
Mame John
Patronymic  Patric
Sumame Smith

4 1. Personal data
Acocess level
Antipazzbac! Mo
Card expiry ¢ Mot specified
Card issued |
Drate of card 27.04.2017 14:0E
Drate of firing Mot specified

m

1D 1.2, Total in region: 1

2

Drate of hiring Mot zpecified
Cubore ol 10

Person

whence wihere

1 k

Description of Regions and areas tab elements is given in the table.

No. Element

1 Areas and
regions tree

Information
on the
selected
area or
region

The list of
users in the
region

List of user
access
cards

User photo
List of user
access

levels

User full
name

User
parameters

Passes log

Description

Hierarchy structure of created areas and regions in the system - see Creating, editing and deleting
Area and Region objects

ID of the area/region and the current number of people in it.

The list of users who are currently located in the region.

Displaying of the list of access cards assigned to user. See also the Assigning an access card to a
user section. This list can be hidden or is not available depending on the Access card settings in
operator rights and/or on the Access manager object (see the Configuring fields displaying in user
accounts section)

Displaying of photo assigned to user. See also the Assigning a photograph to a user section.

List of access levels assigned to user. See also the Assigning access levels to a user section. This list
can be hidden or is not available depending on the Access levels settings in operator rights and/or
on the Access Manager object (see the Configuring fields displaying in user accounts section)

Displaying of user surname, name, patronymic and its ID (in brackets).

Displaying of user information. Description of fields is given in the Setting user parameters section.

Displaying information on users passages in real-time mode.

Working with the Access Manager software module
Starting and stopping the Access Manager module

The Access manager window is a standard interface window of the ACFA Intellect software window. Starting and closing
of this window is performed using the Display menu of the main control panel.

L


https://doc.axxonsoft.com/confluence/display/acfaen/Assigning+a+photograph+to+a+user
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L)' Note
The Access Manager object is to be created on the basis of the corresponding display on the Interface tab to
run the Access Manager software module.

> Close all

Display 1

To display the Access Manager interface window select the Display object on the basis of which the corresponding Acces
s manager object is created. To hide the Access Manager window select the Close all.

General view of the Access Manager window see in the Access Manager module interface section.

S|

=
icon in the Windows system tray. Pointing to this icon =4 the name of the Access Manager object corresponding to the
Access Manager interface window will display.

To close the Access Manager window use the button. So for repeat opening of this window double click the

Note

The module icon is displayed in the Windows system tray depending of the value of the DebugLevel setting in the
HKLM->Software->Wow6432Node->ITV->INTELLECT->Debug branch of the Windows Registry. If this parameter
is set to 0, empty or missing, the icon will not be displayed. If the parameter has a non-zero value, the icon will
be displayed.

General operations with the Access Manager interface elements
Selecting a view of displaying objects list in the Access Manager

In the Access manager software module it's possible to configure the view of user lists, time zones and access levels. The
following displaying types are available:

1. List.

; Smith Jeremy

2. Table.
Full Name | Dateofcardissue | PINc.. | Userlocked | Antipassback |

:. Smith John ~ 071.01.0001 0:00:00 Mo Mo
:. Smith Jeremy 13.04 2016 13:25:11 Mo Mo

3. Large icons.

A <
a a

Smith John Smith Jeremy

.[:D Note

The Large icons view is used on default for user list, times and zones and regions and areas list; Table and List
views are used for access levels. The latter can not be changed.

To select the view of displaying use functional menu opened by right mouse click in free space of objects list.
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Smith Jeremy

List
Table
Large icons

Search »

Selecting a way of sorting objects in the list

In the Access Manager software module it's possible to select the following ways of sorting user lists, time zones and
access levels if the List or Large icons view is selected:

1. By name.
2. By number.

To select the way of sorting use functional menu opened by right mouse click in free space of objects list.

Smith John

View g l
Mew By number

Search F l

To sort values in the list by some field if the Table view is selected, click the left mouse button on the title of column with
field name.

Full Mame Diate of card issue PIM code

|User locked | Antipassback Card
s Smith Jerermyi 13.04.2016 13:25:11 01.01.0001 0:00:00

a Smith John  01.01.0001 0:00:00 Mo Mo 01.01.0001 0:00:00

Change elements sizes of the Access Manager window interface

It's possible to change elements sizes of the Access Manager window interface using mouse. Pointing to border between
interface elements of the Access Manager window, the cursor will be as follows.
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RL=IF
fan]
Departments @ Time zones a Access levels
- e Department 1 User card |
o Department 2 ()
o Department 3 p
------ . Department 4 -
Smith John Access level | Comment |
Access Level 1 Inherted
E—»] Smith Jeremy ()
Basic | Additional I
2= 4l =
B 0. Full name =
Mame Jeremy
Patranymic
Sumame Smith
E 1. Personal data
Access level
Artipassback No
Card expiry dz Not specified
Ql +| Card issued by el
Date of card iz 13.04 2016 1325
Access leve Access Level 1 Date of fiing Mot specified
Extemal 1D Date of hiing: Mot specified
D 1 BExternal ID
Name Department 1 Mumber of car 0
Type of dep Main Office phone
Users 2 Origin
Passport numk
Personnel num
PIN cnde X

It's possible to move the border between interface elements holding the left mouse button.
Key combinations for working with objects lists

Use key combination described in the following table while working with lists of users, time zones and access levels.

The object list is to be active for using hot keys. So before using key combination click the left mouse button on area of
object list.

@ Note

To use Ctrl+Del and Ctrl+Backspace key combinations select the object in the list.

Key combination Description

Ctri+F Search for object.
Ctrl+N Create new object.
Ctrl+Del Delete object.

Ctrl+Backspace

Working with time zones in the Access Manager software module

General information about time zones in the Access Manager software
module

Working with time zones is performed on the Time zones tab of the Access Manager window.



23

@ Access Manager 1

_ ol x|
; Departmentsl (_::;J Time: zones | & Access Iemrelsl

Mame | Mumber |
£ Development department schedule
i Sales department schedule

! Time zone 1

Sales department schedule (ID 1)
Interval | Mon | Tue | Wed | Thu | Fri | Sat | Sun | Holiday |

! Time zone 2

-h-l'.p-‘lll\.'l

Huoliday editor

Time zone is used as working schedule in the Access Manager software module. It's possible to set intervals of two types:

1. Week interval. Time interval is set for specified days of the week.
2. Intervals of shift schedule. Interval is repeated with specified period starting from the specified day.

1 Attention!

Few types of hardware support shift schedules in spite of their supporting in the Access Manager software module.
At most, time zones with shift intervals will be ignored by ACS integration. Exception to this case applies if

integration supports operation in the "Access request" mode when hardware request the integration on access
through the specified access point.

Creation of a time zone in the Access Manager software module

To create time zone, do the following:

1. Go to the Time zones tab of the Access Manager window (1).
@ Access Manager 1

-
Eon

Departmerts _I'; Time zones ﬁ Access levels |
Name |_Number |

L} Time zone 1 1

L) Tirme zone 2 2

View k

M2

Quick search

2. Click the right mouse button in free area of time zone list. The functional menu will be opened.
3. Select the New item (2). The Edit time zone window will open.
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x

o Week intervals
i Intervals of shift schedule

Save Cancel

4. Enter the name of creating time zone in the Name field.

.[:D Note

If time zone with specified name is already exists, than the corresponding message will be displayed while
saving.

5. Add week intervals to the time zone if it's required:
a. Click right mouse button on the Week intervals line and select the Add item in the opened functional
menu.

x

Time zone 1

Wart- =tee e

(L=

b. New interval will be created in the Week intervals group. Panel of interval configuring will display at the
bottom of the Edit time zone window.

(D Note

Name of the interval is a time period and specifying days in which interval operates within brackets.
Apart of week days separated by commas, the following values can be specified:

1. Empty interval.

. Whole week.

. Whole week and on holiday.

. On workdays.

. On workdays and on holiday.

. On the weekend and on holiday.

. On the weekend.

0 N o u A~ W N

. Only on holiday.
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c. Enter or set using slider time of interval start in the Start field (1).

x

Mame I Time zone 1

=3 Week intervals
. - 08:00-18:00 (Mo, Tu, We, Th, Fi)
i Intervals of shift schedule

2
o
&
=

O M b M M M [} [ g
Sun Mon Tue Wed Thu R Sat] Holidays

3 Sve | Concel |

d. Enter or set using slider time of interval end in the End field (2).
e. Set checkboxes corresponding to days in which interval should operate (3).
f. If it's required to eliminate holidays from the interval, set the Holidays checkbox (4).

@ Note

Working with holidays is described in the Edit holidays section.

@ Note

To delete interval, click right mouse button on the interval and select the Delete item in the
opened functional menu.

@eicomezone x

Mame I Time zone 1

= ".'lg'eel-: intervals
B 08:00-13:00 (c
i Intervals of shift sq

g. Repeat steps a-f for all required week intervals.
6. Add intervals of shift schedule to the time zone if it's required:
a. Click right mouse button on the Intervals of shift schedule line and select the Add item in the opened
functional menu.

x

MName I Time zone 1

- Weeltintervals
B Intervals of shift seb-d -

b. New interval will be created in the Intervals of shift schedule group. Panel of interval configuring will



26

display at the bottom of the Edit time zone window.

(D Note

Name of the interval is a date of interval start, time interval and period of interval repetition in
days.

c. Enter or set using slider time of interval start in the Start field (1).

§ Edit time zone

Mame

B

Time zone 1

— Interval parameters

Week intervals
=) Intervals of shift schedule
B From Monday, June 27, 2016 (08:00-18:00) period 7

Start 8:00:00 AI'I-'E:

End | 6:00:00 PV

%
M’

Start date

I Monday

June E;I

Period I T 5: 4

3

Save

Cancel |

d. Enter or set using slider time of interval end in the End field (2).

e. Enter the start day of shift schedule in the Start date field using keyboard or calendar opened by

tton clocking (3).

Start date

e e o

Monday . June

4=  Period

[ Today: 6/27/2016

Sun Mon Tue Wed Thu Fi  Sat
29 30 I 1 2 3 4
5 6 7 8 % 10 1
12 13 14 15 16 17 18
19 20 21 22 23 24 25
26 | 28 2% 30 1 2

El+

bu

f. In the Period field using up-down buttons enter the humber of days in which the interval of shift schedule

will be

®

repeated (4).

Note

To delete interval, click right mouse button on the interval and select the Delete item in the

opened functional menu.
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MName I Time zone 1

Week intervals
=8 Ir_rtenrals af shift schedule
& From Monday, June 27

2016 g fiod 7

g. Repeat steps a-f for all required week intervals.
7. Click the Save button.

x

MName I Time zone 1

=R Week intervals
- 08:00-18:00 (Mo, Tu, We, Th)
i Intervals of shift schedule

Creation of time zone is completed. Created time zone will be displayed in the list.

Iil Access Manager 1

. @ Time zone:
aa Departments !

MName | MNumber |
{ ) Time zone 2 1

() Time Zone 2 2

.L.

Editing a time zone in the Access Manager software module

Editing of time zone involves adding and deleting intervals from time zone and changing configured intervals. To start
editing of time zone double click the required time zone in the list on the Time zones tab. As a result, the Edit time zone

window will open.

Working with this window is the same as while creating time zone - see Create time zone section.

27



£ Edit time zone

x|
MName I i

=R ‘.'Ig'eek intervals
- - 08:00-18:00 {on workdays)
i Intervals of shift schedule

— Interval parameters

Start | 8:00:00 5: i,
End [180000 =] J
M WM M MM O O 0O
Monm Tue Wed Thu Fi 5Sa  5Sum Holidays
Save Canicel

Also this window can be opened by double click of left mouse button on interval in the list of selected time zone. The
clicked interval will be selected in the opened window.

Note

The first interval will be selected while clicking the time zone in the Edit time zone window

IQ! Access Manager 1

i ] |
; Departments @ Time zones ﬁ Access levels
Name I Mumber I
{ -} Time zone 2 ]

Holiday editor |

Search for time zone

Going to search for time zone

In the Access Manager software module it's possible to search for time zone by name and ID. To search for time zone, do
the following:

1. Go to the Time zones tab in the Access Manager window (1).



@ Access Manager 1

~ F Ly ™
ain Departments F Access Ievelsl

Mame I Mumber I
L Time zone 2 1 Interval | Mon [ Tue
{ *1 Time Zone 2 2
“iTime zone 1 3
View ¥
Sorting L
Mew

2. Click the right mouse button in free area of time zone list.
3. In the opened functional menu select the Quick search item. The Search for time zone window will open.

Going to search for time zone is completed. Working with the Search for time zone window is described in the Working
with the Search for time zone window section.

Working with the Search for time zone window

The Search for time zone window is opened while searching for time zone (see the Going to search for time zone) or
while configuring access level (see Creation of an access level section).

Working with the Search for time zone window is performed as follows:

1. If it's required to filter time zones by name, enter the name or its part in the Name field (1). If name of time zone
is not specified, the filtering by this field won't be performed.

x

— Seanch parameters
Mame I departmert]| 1
D i
IHemmre empty r 3
Mame | Mumber |
Development department schedule 2
Sales department schedule 1

2. Ifit's required to filter time zones by ID, enter identical number of required time zone in the ID field (2). If ID is
not specified the filtering by this field won't be performed.

If time zones without intervals are not required in search result, set the Remove empty checkbox (3).

Click the Enter button on the keyboard.

Time zones satisfying to search terms will be displayed in the table of search results (4). Search is case-insensitive.
All objects corresponding fields of which contain specified values will be found.

uhw

To sort search results click the left mouse button on title of corresponding column.

29
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While double click on time zone, the Search for time zone window will be closed and corresponding time zone will be
selected in the list in the Time zones tab or will be added to configured access level.

Search for time zone is completed.
Editing holidays
To edit holidays, do the following:

1. Go to the Time zones tab of the Access manager window.
2. Click the Holiday editor button.

@ Access Manager 1

~ B o]
Name Number |

e
{ ! Development department schedule 2
{ ~1 Sales department schedule 1

Departments

2

Holiday editor II

3. The Edit holidays window containing list of holidays will be opened.

Edit helidays x|

Save Cancel

4. To add holiday click the right mouse button in free area of holidays list and select the Add item in the opened
functional menu. The calendar will display.
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5. Select holiday date in the calendar (1) and click the OK button (2). The holiday will be added to the list.
= Edit holidays

KA

6. Repeat steps 4-5 for all required holidays.

Note
To delete holiday click the right mouse button on it and select the Delete item in the opened functional
menu.




32

= Edit holidays

Mor == T

7. Click the Save button.
ol Edit holiday=
Monday, May 09, 2016

Editing of holidays is completed.

Working with access levels in the Access Manager software
module

General information about working with access levels in the Access
Manager software module

Working with access levels is performed on the Access levels tab of the Access Manager window.
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-~ ™ =
an Departments @Tlmemn&a B Acoess levels "'.j Regions and areas

(g Access level 1
- Access level 2
== New folder
o a Access level 3
Access level 1 (ID 1)
Access point ] Time zone Am Dizam Load
{Bio Smart-mini 1.1.1 1.1 Time zone " Always" + + +

The Access Manager software module allows creating, editing, viewing and deleting access levels. At that, possibility of
creating, editing and deleting access levels can be forbidden while configuring the Access Manager software module - see
the Rights for configuring access levels in the Access manager section.

Creation of an access level in the Access Manager software module

To create access level, do the following:

1. Go to the Access levels tab of the Access Manager window (1).

17 Access Manager 1

= 1

M
n Access levels

] —
an Departments | C") Time zones \j Regions and area5|

g Access level 1
Access level 2
B New folder
a Access level 3
Access level 1 (ID 1)
Access point ID Time zone Am Digarm Load
‘BioSmart-mini 1.1.1 111 Time zone "Always" + * i

2. There are two ways to create a new access level:
a. Right-click in the free area of the access level list and select Create root level (1) in the functional menu.
In this case, the access level will be created in the root list of access levels.
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3.

12 Access Manager 1

-~ [
an Departments @Tmemms n Access levels Q Regions and areas

e Access level 1
----- Access level 2
== New folder

q | Create root level

Create root folder

Quick search

b. Right-click the folder and select Create access level (2). In this case, the access level will be created in the
selected folder.

>
2> Access Manager 1

- ™
an Departments @Tmezm B Access levels Q Reqions and arsas

e Access level 1
----- Access level 2
EE olde
e focesz | 2 | Create access level
CreateFolder
Delete
Change folder

If you select any of the commands, the Edit access level window will open, enabling you with the following
actions:

Name 1 |

Save ] [ Cancel

a. In the Name field enter name of the access level (1).

(D Note

Name of access level should be unique. If access level with such name is already exists in the
system, the corresponding message will display while saving and access level won't be saved.

b. Add link between the access point and the time zone. This can be done in two ways either.
i. If it's required to add link for reader of such type for which links are already exist in the list, click the
right mouse button on the name of link and in the opened functional menu select the Add link of



the same type item and go to step 4. If there is only one access point of this type for which link is
not assigned, go to step 4.

B e

Mame Access level 1

Add link of the same type
Delete link of the same type

Link parameters

Access point [EiuSmart-mini 1.1 v] @
Time zone [TiITIE zone " Always" v] @
Am Digam Do not load

! [ Save ][ Cancel ]

ii. If it's required to add link for access point of new type, click the right mouse button in free area of
access rules list and in the opened functional menu select the Add link of another type item and
go to step 4. If there is only one access point for which link is not assigned, go to step 4.

r =
B oo D et

Mame Access level 2

Add link of another type

Note
{D If links for all created readers of this type are assigned in the access level, the message
about failure to create new link will display because only one link can be added for each

reader.

4. When type of rule is selected, the Search for access point window will be opened. In this window all access point
are grouped by object types in the ACFA Intellect software. To search for and select an access point, you must do
the following:
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Search parameters
Type [NI types of access points v] 1
Area [ v] 2
Region [ v] a2
Name 4
0 5
[=I- BioSmart 4

[=J- BinSmart-mini
[=J- BinSmart reader
[=I- Gate Parking access point

[=- FACE access point

‘... BioSmart 4 1.1(1.1)

‘... BioSmart-mini 1.1.1(1.1.1)
‘... BioSmart reader 1.1.1(1.1.1) 6
‘.. Gate Parking access point 1(1.1)

‘.. FACE access point 1.1(1.1)

-

- TQ A0 QN TO

Find and select access point as follows:

Select type of access point from the Type drop-down list if it's required (1).

Select the location of the access point from the Area drop-down list if it's required (2).

Select the location of the access point from the Region drop-down list if it's required (3)

Enter name of access point or its part in the Name field if it's required (4).

Enter ID of required access point in the ID field if it's required (5).

The search will be performed automatically. The list of search results will be displayed below (6).
Double-clicking the required access points, thus highlighting them in bold.

Click OK button when access points are selected (7).

5. You WI|| go back to the Edit access level window. The panel for configuring the access level will be displayed at the

bottom.



37

3 Edit access level t ﬁ

Mame Access level 2

=- B!DSmart-mini
. BioSmart-mini 1.1.1(1.1.1) - Time zone "Aways

Link parameters
1 | Access point [EinSmart-mini 1.1.1 v] @

2 Time zone [m
3- 4 | Disarm [+ 5 | Do not load .l

ﬁl Save I[ Cancel ]

%

Access point specified in the search is selected in the Access point drop-down list (see step 4) or the first from
free access points of selected type. Select the access point through which access will be allowed with configured
access level from the Access point drop-down list if it's required (1).

Click the @ button and go to step 4 if it's required to search for access point.
From the Time zone drop-down list select time zone during which access through the selected access point will be
allowed to users with configured access level (2).

Click the @ button if it's required to search for required time zone - see the Working with the Search for time
zone window section.

Note

@ Time zones are created and configured on the Time zones tab of the Access Manager window - see the
Working with time zones in the Access Manager software module section. Also it's possible to use system
time zones "Always" and "Never".

Set the Arm checkbox to arm access point after presenting access card by user (3).
Set the Disarm checkbox to disarm access point after presenting access card by user (4).
If it's not required to send access cards to controller after presenting access card by user, set the Do not load chec

kbox (5).
1 Attention!

Functions of arming, disarming and sending access cards should be supported by hardware.

Note.
@ Function of the Do not load checkbox can differ depending on the integration module in use. For example,
in PERCo-S-20 integration this checkbox enables commission mode.

11. Repeat steps 3-10 for all required links.
12. Click the Save button (6).

Created access level will be displayed in the list.
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- ™
e Departments (B Time zones | [N Acoess levels Q Regions and areas

e Access level 1
b Access level 2

- Access level 4

E' Mew folder

Creating of access level is completed.

Editing an access level in the Access Manager software module

Editing of time zone involves adding, deleting and changing links. To start editing of access levels, double-click the required
access level in the list on the Access levels tab or on the name of access point in the table of access level parameters.

(D Note

The link to the corresponding access point will be selected in the opened Edit access level window as you click
on the name of the access point. The first link will be selected while clicking the access level.

22 Access Manager 1 LE ﬂu

-~ ™
e Departments (B'I“lm&mn&a B Acoess levels Q Regions and areas

Access level 1
Access level 2
b Access level 4
-5 New folder

Access level 4 (ID 4)
Access point 1] Time zone Am Digam Load

Bio Smart-mini 1.1.1 Time zone "Always"

As a result the Edit access levels window will be opened. Working with this window is the same as while creating access
level - see Create access level section.
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Mame Access level 4
= BioSmart-mini
B BioSmart-mini 1.1.1(1.1.1) - Time zone "Aways"

| |
]
i
| |

Link parameters [l
|| Accesspoint | BioSmartmini 1.1.1 -[Q

Time zone [Tl.me zone " Always" v] @
Am Digam Do not load

Going to the time zone

At the bottom of the Access levels tab there is a list of access points added to the selected access level. If the user time
zone related to the access point is not Always and not Never, it's possible to go to this time zone on the Time zones tab.
Right-click the required access point and select Go to time zone in the opened functional menu.

[ - il
2: Access Manager 1 @ﬂu

™
; Departmerts @ Time zones | [[}) Acoesslevels

Access level 1
Access level 2
: Access level 4
-5 New folder

Access level 4 (ID 4)

Access point ] Time zone Am Digarm Load

{BI Go to time zone

As a result, the Time zones tab with the required zone will be opened.
Search for access level

Going to search for access level

In the Access Manager software module it's possible to search for access level by name, ID and access point. To go to
search for access level, do the following:
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1. Go to the Access levels tab of the Access Manager window (1).
L

12 Access Manager1

™
Departments @'ﬂmezones B Access levels \j Regions and areas

Access level 1 1

Access level 2

-
L]

; Access level 4
- New folder Create root level

Create root folder

Quick search

Access level 1 (ID 1)

Access point Time zone

BioSmart-mini 1.1.1 Time zone "Always”

2. Click the right mouse button in free area of access levels list.
3. Select the Quick search item in the opened functional menu. The Search access level window will be opened. For
details on woking with the functional menu, see Managing the list of access levels.

Going to search for access level is completed. Working with the Search for access level window is described in the Worki
ng with the Search for access level window section.

Working with the Search access level window

The Search access level window can be opened while searching for access level (see the Going to search for access level
section), department configuring (see the Add department section), searching for department (see the Working with
Search for department window section) or while user configuring (see the Assigning access levels to a user section).

Working with the Search access level window is performed as follows:

1. Enter name of the required access level in the Name field if it's required (1).

Search parameters
1 MName
2 ID
3 | Folder | -
4 Access point/ Type Ay access levels
" 5 Femove empty ﬁ
=
MName Mumber
Access level 1 1
Access level 2 2
Access level 3 33
Access level 4 4
6
]

2. Enter the identification number of the required access level in the ID field if it's required (2).



3. Select the folder the level is located in from the Folder drop-down list if it's required (3).
4. If it's required set the list of access points which the required access levels should contain:

a. Click the j button. The Search access point window will be opened.

(] -
"% Search access point I&

Search parameters

Type | Al types of access poirts K
Area | = | 2
Region [ v] 3
Name 4

ID 5

i - BioSmart 41.1(1.1)
— - BioSmart-mini
- i BioSmart-mini 1.1.1(1.1.1)
— BioSmart reader 6
. i.BioSmar reader 1.1.1(1.1.1)
— Gate Parking access poirt
‘.. Gate Parking access point 1(1.1)
=) FACE access paint

.. FACE access poirt 1.1(1.1)

Select type of the required access point from the Type drop-down list if it's required (1).

Select the location of the access point from the Area drop-down list if it's required (2).

Select the location of the access point from the Region drop-down list if it's required (3).

Specify the name of access point or its part in the Name field if it's required (4).

Specify the identification number of the required access point in the ID field if it's required (5).

The search will be performed automatically, and the list of search results will be displayed below (6).
Double-click on the required access point in the list (6).

(D Note

To clear the list of access points click the @ button.

T 0000

5. Ifit's required to remove access levels not associated to any access points from the search results, set the Remove
empty checkbox (5).

6. Results of access levels search will be displayed in the list (6). Search is case-insensitive. All objects corresponding
fields of which contain specified values will be found.

To sort search results click the left mouse button on title of corresponding column.

While double click on access level, the Search access level window will be closed and corresponding access level will be
selected in the list in the Access levels tab or will be added to department or user.

Search for access level is completed.

Managing the list of access levels

The list of access levels is managed using the context menu, invoked by clicking the right mouse button on the free space
around the list.



(B'ﬁnezm a Access levels '\;} Regions and areas

: Access level 2
EIE1 Mew folder
‘ a Access level 3

1 Create root level
2 Create root folder
3 Quick search

Access level 1 (ID 1)

Access point D Time zone

BioSmart-mini 1.1.1 1.1 Time zone "Always"

The commands of the context menu are described in the table.

# Command Description

1 Create Adds a new access level to the list of access levels. Clicking the menu item opens the Edit access level
root level window. For more information on creating access levels, see Creation of an access level in the Access
Manager software module.

2 Create Adds a new folger for organizing access levels in the list. Clicking the menu item opens the Folder
root folder settings window, which enables setting the name of the new folder.

3  Quick Opens the window for quick search of access levels in the list. Clicking the menu item opens the Quick
search Search window, which enables searching for access levels by different criteria. For more information on

searching for access levels, see Search for access level.

An individual element of the access level list is managed using the context menu, invoked by clicking the right mouse
button on the free space around the list.

- ™
.
» 3 Access level
- Departments @ Time zones n cess levels

; Access level 1
Access level 2
R ES] Ne dex

-

Create access level
CreateFolder
Delete

Change folder

Access point Time zone
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The commands of the context menu are described in the table.

# Command Description

1  Create Available for the Folder item only. Adds a new access level to the folder. When you select a
access level command, the Edit access level window opens.

2 Create Available for the Folder item only. Adds a subfolder. When you select a command, the Folder
folder settings window opens.

3 Delete Removes an item from the access level list after confirmation from the user.

4  Change Moves the access level list item to the selected folder. When you select a command, the Folder
folder search window with a tree of available folders opens.

5 Move to Available for the Access level element only. Moves the access level from a folder to the root list of
root access levels.

Working with departments in the Access Manager software
module

General information about working with departments

Departments are organized in hierarchy structure in the ACFA Intellect software package. Tree of departments is displayed
in the Departments tab of the Access Manager window.

@ Access Manager 1

Departments | { &4 Time zones

()
ﬁ}l Access levels

Department 1
...... ; MNew department 1
Department 2
: Department 3
o = Department 4

It's possible to create departments on the basis of some existed department and in the root of hierarchy. Functions of
editing, deleting and viewing departments are available. Possibility of creating, editing and viewing departments can be
limited while configuring the Access Manager software module - see the Rights for configuring and viewing departments in
the Access Manager section.

Adding a department

To add department, do the following:

1. Go to the Departments tab of the Access Manager window.



@ Access Manager 1

= Ty ™
o Departmerts | ¢ L Time zones ([} Access levels

- New department 1
o Department 2
o Department 3
v o Department 4

| Create root department I

@ Access Manager 1

] e n
@ Departments t\!r'j Time: zones | (77 Access lev
EI; Department 1
Ql ol s E‘ New departmert 1
Access levels Access Level 1 ~am Departm T e
el TF) i Replace
Extemal 1D o m DEpartm
D 1 Create subsidiary department
MName Department 1
Type of department Main
Users 2

2. To create department in the root of hierarchy click the right mouse button in free area of departments hierarchy
and select the Create root department item in the opened functional menu.
To create department on the basis of existed department click the right mouse button on the required department
and select the Create subsidiary department item.

3. The Edit department properties window will open.

¥ Edit department properties 3 x|
MName I MNew departmert 2

Extemal ID |
Type of depar1 Main j

Basic access level i}-‘-.-:n::ess Level 1 ¥ II

List of additional access levels gl

MName | Mumber |

3

= L) R -

ﬁ Save Cancel

4. Enter the department name in the Name field (1).

.[:D Note

Name of department should be unique. If department with such name is already exist, the corresponding
message will be displayed while saving and department won't be saved.

5. In the External ID field enter external identical number of department (2). This field is in use if list of
departments and users in the database of the ACFA Intellect software package is used with users database in
external software due to features of used ACS integration module.
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6. From the Type of department drop-down list select the department type (3). Types of departments are created
while configuring the Access Manager software module - see the Configuring a type of department in the Access
Manager section. Type of department specifies the list of visible and available for editing fields of user entering to
this department. The Main type of department is the default type of department in the Access Manager module. All
general user fields are visible and available for editing in this department type.

7. From the Basic access level drop-down list select department access level which be inherited on default by all
users entering to this department (4).

Note
Use can not to inherit the department access level - see the Configuring of department access level
inheritance section.

Note

Access levels are created and configured on the Access levels tab of the Access Manager window (see
the Working with access levels in the Access manager software module section). Also it's possible to use
system access levels Always and Never.

8. Ifit's required, specify the list of additional access levels the following way:
a. Ensure that user access level is selected from the Basic access level drop-down list (i.e. not Always and
not Never).
b. Click the Add button in the List of additional access levels table (5).
c. The Search access level window will be opened. To search for access level - see the Search for access
level section.

Note
To delete the additional access level click it the right mouse button and select the Delete item in
the opened functional menu.

* Edit department properties ) x|

MName I Mew department 2

Bdtemal ID |

Type of depar1 Main

Basic access level If—‘u:u:ess Level & j
List of additional access levels gl

':l

Access Level

Save Cancel

9. Click the Save button (5).

Department will be added to the tree.

Note
To delete department click it the right mouse button and select the Delete department item in the opened
functional menu.

@ Access Manager 1

- rﬁ ™
@, Departments I:i: Time zones 0 Access |

El; Department 1

- -l I Delete department I

..... ? gepf REPIECE
.- Epf Replace to root
...... L)

Create subsidiary department




Creation of department is completed.
Editing a department

Editing a department involves changing of department parameters. To start editing a department double click the left
mouse button on the name of department in a tree. The Edit department properties window will open. Working with this

window is the same as while described in the Adding a department section.

% Edit department properties ] X|

MName I Department 1
Extemal ID |
Type of depari Main

Basic access level I..’-‘u:n::ess Lewvel 2

1O 1« 1«

List of additional access levels

MName | Mumber |

Save | Cancel |

Department search in the Access Manager software module

Going to department search

In the Access Manager software module it's possible to search for departments by name, ID, external ID and access level.

To go to department search, do the following:

1. Go to the Departments tab of the Access Manager window (1).

46
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@ Access Manager 1

2. Click the button (2). The Search for department window will open.

earch for department
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Going to department search is completed. Working with the Search for department is described in the Working with
Search for department window section.

Working with Search for department window
Working with Search for department window is performed while searching for department (see the Going to department

search section), replacing user from one department to another (see the Transferring a user to a different department secti
on), and while creating departments hierarchy (see the Creating departments hierarchy section).

Working with the Search for department window is performed as follows:

1. Enter the complete or partial name of a department in the Name field if it's required (1).

=

— Search parameters
MName I | 1
D | 2
Extemal ID | 3
Access levels Any access level j Q,l
5 | Found depatments: 5. | 6
MName | Mumber |
Departmert 1 1
Departmert 2 2
Departmert 3 3
Departmert 4 4
MNew department 1 h

Enter the department ID in the ID field if it's required (2).
Enter the external ID of an object in the External ID field if it's required (3).
From the Access level drop-down list select name of access level which is to be assigned to required department

AN

(4). If it's required click the J button and search for access level (see the Working with the Search access level
window section).

5. Click the Enter key.

6. Number of found departments will be displayed (5) and the list of departments satisfying to the specified search
parameters (6). Search is case-insensitive. All objects corresponding fields of which contain specified values will be
found.

To sort search results click the left mouse button on title of corresponding column.

While double click on department name, the Search for department window will be closed and the department will be
selected in the departments tree or in the form from which the Search for department window was opened.

Department search is completed.
Creating departments hierarchy
The departments hierarchy is created using the following operations:

1. Changing of parent department. Click the right mouse button on department name in the list of departments and
select the Replace item in the opened functional menu. As a result the Search for department window will open
to select the new parent department - see the Working with Search for department window section.


https://doc.axxonsoft.com/confluence/display/acfaen/Transferring+a+user+to+a+different+department

49

l @ Access Manager 1

-
™
= Departments {E Time zones n Access levels
Elq. Eepartmenﬂ |
P e
2 Department 2 Delete department
..... ; Department 3 I Replace I
e ; Department 4 Replace to root

Create subsidiary department

2. Replacing subsidiary department to the root of hierarchy. Click the right mouse button on department name in the
list and select the Replace to root item in the opened functional menu. As a result the department will be places
to the root of departments hierarchy.

| @ Access Manager 1

™~ ™
o Departments (E Time zones n Access levels
El an Department 1 |

...... - W-D.elete department

- o Department 2

..... ; De.partment 3 F“Eﬂ
T Replace to root
------ o Department 4 pl

Create subsidiary department

3. Change the department location by dragging it with the left mouse button holding the Ctrl key.

(D Note

Department replaces in hierarchy with its subsidiary departments.

Working with users in the Access Manager software module
Viewing a list of users

To view users select one of departments in the tree. A list of users included to this department will be displayed in the
middle part of the Access Manager window.
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Ifi Access Manager 1

)
o Departments @ Time zones

m
n Access levels

=101 x]

Department 1
; Mew department 1
o Depatment 2
; Department 3
- o Department 4

al]

=

Smith John

User card |

Access level |Cammer|t |

Access levels Access Level 1
Bxdemal 1D

D 1

Mame Department 1
Type of departmer! Main

Users 2

Access Level 1 Inherited

Smith Jeremy (2)
Basic | Addtional I

| »

Patrorymic
Sumame Smith

E 1. Personal data
Access level 2
Artipassback Mo
Card expiry da Mot specified
Card issued by o
Date of cand is 13.04.2016 13:25
Date of firing Mot specified
Date of hirng: Mot specified
Bxtemal 1D
MNumber of car §
Office phone
Crigin
Passport numt
Personnel num

Cilkl 1

Properties of the selected user are displayed in the right part of the Access Manager window. On default the first user

from the list will be selected while viewing the department.

Note

In case of large number of users in the department (more than 2000), displaying of users list can take for some
time. Time of displaying a users list depends on computer capacity on which the Access Manager window is

displaying.

Creating users in the Access Manager

To add a new user, do the following:

1. Open a list of user (see the Viewing a list of users section).

2. Click the right mouse button in free area of user list.




EE =

-~ M
o Departments @ Time zones o] Access Ievelsl
=l o, Department 1 = User card |
R ; New department 1
Department 2 |
Department 3 -
o Departmert 4 Smith John Access level | Comment |
View 4
Sorti 4
I New
Search ¥ ;
=ar Basic |Md'rtional|

al4]

Access levels Access Level 1

Exdemal 1D

D 1

Name Department 1
Type of departmend Main

Users 2

{D Note

Rights for users creating can be limited while configuring the Access Manager module. The message about

missing of corresponding rights will display. See also the Rights for users configuring in the Access
Manager section.

3. Select the New item in the opened functional menu. The Full name of new user window will open.

* Full name of new user x|

SLmamel

Namel

Patronymic |
QK |

4. Enter surname, name and patronymic of creating user and click OK button.

(D Note

If criterion of records duplicate is in use and there is user with such name in the system, the error
message with ID of existed user and department to which the user belongs will display. See also the Confi
guring parameters of users creation in the Access Manager section.

x

.'\'-I This user (ID 1, department Department Caseworkers with ID 3)
" already exists in card file

(|

5. The Editing. <User name> (creation) window will display.



Further process of user creation is given in the Editing a user section.
Editing a user

Going to user editing

Going to user editing is performed while user creating (see the Creating users in the Access Manager section) or as follows:

1. Open list of users (see the Viewing a list of users section).
2. Double click the left mouse button on the required user. The Editing. <User name> (ID) window will open.

* Editing. Smith Jeremy (2) i = |EI|1|
Uzer card Access level Comment

Access Level 1 Inhented

= =
B 0. Full name | B Others
Name Jeremy Rawelin Access type
Patromymic Ravelin guest card Mo
Sumame Smith
B 1. Perzonal data
Access level assigned by
Antipassback No
Card expiry date Not specified
Card issued by
Date of card issue Cp. 13 anp 2016 13:25:11
Diate of firing Mot specified |
Date of hirng: Mot specified
Bdemal ID
Number of card loss 1]
Cffice phone
Crigin
Passport number
Perzonnel number
PIN code
Pasition
Telephone i

Save Cancel

It's possible to do the following operations in this window:
Setting user parameters

Assigning access card to user

Assigning access levels to user

Assigning photo to user

Adding biometric parameters (fingerprints)

Poeooo

All actions are described as follows.

(D Note

Rights for user editing can be limited while configuring the Access Manager module. The message about missing of
corresponding rights will display after double click on the user name. See also the Rights for users configuring in
the Access Manager section.

Fields available for editing including list of access levels and list of access cards are specified while configuring the Access
Manager software module - see the Configuring fields displaying in user accounts section. Some fields can be hidden or not
available for editing depending on settings.

Going to user editing is completed.
Setting user parameters

User parameters are specified in the Editing. <User name> (ID).



? Editing. Foreman Susan

There are following general user parameters in the ACFA Intellect software package.

Note
Availability of some additional parameters depends on used integration module.

Parameter
name

Surname

Name

Patronymic

Personnel
number

External ID

Position

Date of
hiring

53

Parameter
setting method

Enter the value in
the field

Enter the value in
the field

Enter the value in
the field

Enter the value in
the field

Enter the value in
the field

Enter the value in
the field

Enter the value in
the field manually
or using the
calendar

Default
category
in
templates

0. Full
name

0. Full
name

0. Full
name

1.
Personal
data

1.
Personal
data

1.
Personal
data

1.
Personal
data

Value range

All symbols

All symbols

All symbols

All symbols

All symbols

All symbols

Date in
Weekday, DD
mmm YYYY
HH:MM:SS
format

Comment

This field is in use if list of departments and users in the database
of the ACFA Intellect software package is used with users database
in external software due to features of used ACS integration
module.
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Date of
firing

Temporary
AL activation
date

Temporary
AL expiry
date

Date of card
issue

Card expiry
date

Date of card
issue

Number of
card loss

PIN code

Antipassback

User locked

Additional
information

Driving
license

Vehicle
model

Vehicle LP

Telephone

Office phone

E-mail
address

Passport
number

For visitor:
from where

For visitor:
to which
department

Enter the value in
the field manually
or using the
calendar

Enter the value in
the field manually
or using the
calendar

Enter the value in
the field manually
or using the
calendar

Enter the value in
the field manually
or using the
calendar

Enter the value in
the field manually
or using the
calendar

Enter the value in
the field manually
or using the
calendar

Enter the value in
the field

Enter the value in
the field

Select the value
from the list

Select the value
from the list

Enter the value in
the field

in

Enter the value
the field

Enter the value in
the field

Enter the value in

the field

Enter the value in

the field

Enter the value in

the field

Enter the value in

the field

Enter the value in

the field

Enter the value in

the field

Enter the value in

the field

1.
Personal
data

1.
Personal
data

1.
Personal
data

1.
Personal
data

1.
Personal
data

1.
Personal
data

1.
Personal
data

1.
Personal
data

1.
Personal
data

1.
Personal
data

1.
Personal
data

3. Vehicle
3. Vehicle
3. Vehicle

1.
Personal
data

1.
Personal
data

1.
Personal
data

1.
Personal
data

4. Visitor
data

4. Visitor
data

Date in
Weekday, DD
mmm YYYY
HH:MM:SS
format

Date in
Weekday, DD
mmm YYYY
HH:MM:SS
format

Date in
Weekday, DD
mmm YYYY

HH:MM:SS
format

Date in
Weekday, DD
mmm YYYY
HH:MM:SS
format

Date in
Weekday, DD
mmm YYYY
HH:MM:SS
format

Date in
Weekday, DD
mmm YYYY

HH:MM:SS
format

Numbers

Numbers

Yes

No

Yes

No

All symbols

All symbols

All symbols

All symbols

All symbols

All symbols

All symbols

All symbols

All symbols

All symbols

To use temporary access levels the Support temporary access
levels object is required. This object is created on the basis of the
Computer object on the Hardware tab of the System settings wi
ndow

Default value depends on configuring the Access Manager module -
see the Configuring parameters of users creation in the Access
Manager section.

Yes - user locked.

HeT - user is active.

Enter additional information in text field opening by clicking the
"down" button in the Additional information field

Number of user driving license

Model of user vehicle

License plate of user vehicle

Telephone number

Office phone number

User e-mail address

Passport number of user

Name of organization to which the visitor belongs

Department being visited
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For visitor: Enter the value in 4. Visitor All symbols
to whom the field data
For visitor: Enter the value in 4. Visitor All symbols
purpose of the field data
visit
For visitor: Enter the value in 4. Visitor All symbols
document the field data
For visitor: Enter the value in 4. Visitor All symbols
registration  the field data
address
For visitor: Enter the value in 4. Visitor All symbols
birth place the field data
Card issued  Automatically 1. Operator name
by Personal

data
Access level  Automatically 1. Operator name
assigned by Personal

data

Assigning an access card to a user

Employee being visited

Purpose of visitor visit

Present document of visitor identification

Address of visitor registration according to place of residence

Place of visitor birth

Name of operator who last assigned access card to user or visitor
(see the Assigning an access card to a user section)

Name of operator who last assigned access level to user or visitor
(see the Assigning access levels to a user section)

General information about assigning access cards to a user

List of user access cards is displayed in the User card table of the Editing. <Full name> (ID) window.

? Editing. Foreman Susan (3)

lser card

Access level | Comment

=101 x|

(123) 7850

Bz 4l |2

"Mever" Inherted

=

=

0. Full name
Mame

Patrormymic
Sumame

1. Personal data

Access level assigned by

Antipassback
Card expiry date
Card issued by
Date of card issue
Diate of fiing

Date of hirng:
Edemal 1D
Mumber of card loss
(ffice phone
Origin

Passport number
Personnel number
PIM code

Position
Telephone

Foreman

No

Mot specified

Admin 1

Mon, 27 Jun 2016 14:01:06
Mot specified L
Mon, 27 Jun 2016 14:01:06

0

Save Cancel

The object code is specified in brackets, then the card code follows.

It is possible to assign several access cards to a user.

Attention!

Assigning several access cards to a user should be supported by hardware. If used hardware supports only one
card and several cards are assigned to a used, then all cards excepting the first card will be ignored by system.



Input of card number and code while assigning access cards to a user can be performed in one of the following ways:

1. Manually.
2. Using the control reader.

Note
List of control readers used for user access cards input is specified while system configuring - see the Selecting
control readers in the Access Manager section.

Input of access card humber manually

To input access card number manually, do the following:

1. Go to editing a user (see the Going to user editing section).
2. Click the right mouse button in card selection area.
3. Select the Add item in the opened functional menu.

T Editing. Smith Jeremy (2}
|User card | Access level |

(123) 558645 | Access Level 1

|

From reader

4. The window of input object code and card code will open.
Edit card El

11 Roomcode 578

2 | Card number 1645
3 ok | coca |

Enter the object code (facility-code, room code) in the Room code field (1).
Enter the card code in the Card number field (2).

Click the OK button (3).

The card will be added to the list.

¥ Editing. Smith Jerem
Iser card

(123) 353649
(978) 1649

©ONow

Note
To delete a card number from the list click the right mouse button on the card number and select the Delete item

in the opened functional menu.

® Editing. Smith Jeremy (2}
User card Access level

(123) 958645 Access Level 1

(378)

Input of access card number manually is completed.
Input of card humber using a control reader
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To input access card number using a control reader, do the following:

1. Go to editing a user (see the Going to user editing section).
2. Click the right mouse button in card selection area.
3. Select the From reader item in the opened functional menu.

* Editing. Smith Jeremy (2)
Iger card Access

(123) 953649 Access

Add |
I From read'e-r I

4. The Access card reading window will open.
Access card reading [ |

1 =l =y - | Gate Parking access point 1)kl

2 I Start reading |I

Start reading or select another control reader

5. From the Reader type drop-down list select a control reader which will be used for input of access card number

(D).

Note
(D List of accessible control readers is specified while system configuring (see the Selecting control readers in
the Access Manager section).

6. Click the Start reading button (2). The Access card reading window will be as follows:

Access card reading |

Reader type I'Sa!e Parking access poirt 1 vI

| Cancel reading I

Present card to the selected contral reader...

Note
(D To cancel access card reading click the Cancel reading button.

Present access card to the selected reader.
If confirmation of card input by operator is configured, the Confirmation of card input window will display. To assign

presented card to a user click OK, to come back to step 12 click Cancel.
See also the Selecting control readers in the Access Manager section.

Confirmation of card insert @

® N

-

"-.I (0) 7 card is presented.
' OK - add card to user, Cancel - continue to wait for the next card.

Ok ] [ Cancel

9. Then the Access card reading window will be closed and number of presented access card will be added to the
list.
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{123) 558645
(13) 14572 |

(D Note

If this card is already given to the current or another user, the corresponding window will display.

This card has already given to the user This card has already given to user Jeck with number '4'

—— [ o ]

Note
To delete a card number from the list click the right mouse button on the card number and select the Delete ite
m in the opened functional menu.

Input of access card using a control reader is completed.
Assigning access levels to a user

General information about assigning access level to a user

List of access levels is displayed in the table of the Editing. <User full name> (ID) window.

? Editing. Smith Anna (2)

Access level 2
Access level 1
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In the Comment column it's specified whether access level is inherited by Department (Inherited), temporary (Tempora
ry) or assigned to a user separately (Own). Configuring rules of department access level inheritance is described in the Co
nfiguring of department access level inheritance section. Adding of own access levels to a user is described in the Assigning
own access level to a user section. Assigning temporary access levels is described in the Assigning temporary access level

to a user section.

Assigning own access level to a user

Assigning own access level is performed as follows:

a. Go to editing a user (see the Going to user editing section).
b. Click the right mouse button in the access levels list.

r Bl
L. Editing. Jeremy Smith (1) [

Uzer cand Access level  Comment
(-} DOODDO1 "Always" Inherited
| Basic AL

Add

—

Set full access

Set access restriction

Do not inherit department AL

e e B

c. To assign user access level select the Basic AL -> Add item in the opened functional menu (1). The window
of access level searching will open. Search for access levels required access level (see the Search for access
level section) and select any number of access levels by double-clicking them (selected levels will be
highlighted in bold):

Search parameters

MName

0]

Access point/ Type

0 sechscsten

|t

Ary access levels

Q)

Remove empty [ |
MName Mumber
Access level 1 1

Accesslevel2 | 2 |

Access level 3

3

(D Note

If Always or Never own access levels are assigned to a user, then no other access level can be assigned.

1. To assign the Always access level to a user, select the Basic AL -> Set full access (2).
2. To assign the Never access level to a user, select the Basic AL -> Set access restriction (3).

., Editing. Jeremy Smith (1)

User card

(-} 0000001

Access level

Access level 1
Access level 2
"Always"

Comment

Own
Own
Inherted

[ |

=

Assigning own access level to a user is completed.

Configuring of department access level inheritance



User can inherit department access level on default. If it's required not to inherit department access level (levels), do the
following:

1. Go to editing a user (see the Going to user editing section).
2. Click the right mouse button in the access levels list.

# Editing. Smith Jeremy (2}
|zer card Access level | Commenrt

(123) 558645 Access Level 1 Inhented
(13} 14572
e

Set full access

Set access restriction
Do not inherit department AL

3. Select the Basic AL -> Do not inherit department AL in the opened functional menu.

Note

(D It's impossible to delete inherited access level if a user haven't got own access levels. In this case it's required to
assign own access level to a user and then disable inheritance of department access level - see the Assigning own
access level to a user section.

As a result the inherited access level (levels) will be deleted from the list.

To restore inheritance of department access levels, do the following::

1. Click the right mouse button in access levels list.
2. Select the Basic AL -> Inherit department AL in the opened functional menu.

* Editing. Smith Jeremy (2)
|ser card Access level Comment

(123) 958645 Access Level 3 Chwr
(13) 14572
Basic AL P Add

Set full access
Set acoess restriction
| Inherit department AL

As a result the inherited access level (levels) will be added to the list.

Configuring of department access level inheritance is completed.
Assigning temporary access level to a user

If the Support of temporary access levels object is created, start time of temporary access level and end time of
temporary access levels are specified, it's possible to assign temporary access levels to a user

To assign temporary access level to a user, do the following:

1. Go to editing a user (see the Going to user editing section).
2. Click the right mouse button in the access levels list.

' ditng. Smitderemy @)
|ser card Access level Comment

Access Level 1 Inherted
Access Level 1| Temporary, inherited

Basic AL g
Temporary AL ¥ Add

Set full access

Set access restriction

: = Do not inherit department AL

ool -

3. To assign user access level, select the Temporary AL -> Add in the opened functional menu (1).

4. The window of access level searching will open. Search for access levels and select the required access level (see

the Search for access level section).

(D Note
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If Always or Never own access levels are assigned to a user, then user access level can't be assigned.

To assign the Always access level to a user, select the Temporary AL -> Set full access (2).

To assign the Never access level to a user, select the Temporary AL -> Set access restriction (3).

Assigning own access level to a user is completed.

To disable inheritance of department temporary access level, select the Temporary AL -> Do not inherit department
AL (4). See the Configuring of department access level inheritance section.

@Now

Assigning temporary access level to a user is completed.
Assigning a photograph to a user in the Access Manager software module

General information about assigning a photograph to a user

Assigning a photograph to a user is performed in the Editing. <User full name> (ID) window in one of the following
ways:

1. From a file.
2. From a video camera.

Note
List of video cameras used for assigning photograph to users is specified while system configuring (see the Selecti
ng available cameras in the Access Manager section).

1 catng.foremansusan )
Iser card Access level Comment

Access level 1 Inhernted

=
B 0. Full name -
Mame Susan
Patrormymic
Sumame Fareman
B 1. Personal data
Access level assigned by
Artipassback No
Card expiry date Mot specified
Card issued by
Date of card issue Mon, 27 Jun 2016 14:01:06
Date of firng Mot specified I
Date of hiring: Mon, 27 Jun 2016 14:01:06
Bdemal 1D
Mumber of card loss 0
Cffice phone
Origin
Passport number
Personnel number
PIM code
Position

Telephone B

Save Cancel

Assigned photographs are storing in the <ACFA-Intellect installation directory>/Bmp/Person folder. Name of file with the
user's photograph is the same as the user ID. Content of the Bmp/Person folder is synchronized on all servers of
distributed system.

Assigning photograph from a file

To assign photograph from a file, do the following:

1. Go to editing a user (see the Going to user editing section).
2. Click the right mouse button in user photo area.
3. Select the Assign picture -> Select file in the opened functional menu.



? Editing. Adamson Jessica (creation) N ;Iglﬂ
Usger card Access level Comment [Y——— m

Access Level 1 Inherited

From camera

4. The standard dialog window will be opened. Select the file with photograph.
Opened photograph will be assigned to the user.

Assigning photograph from a file is completed.
Assigning photograph from a video camera

To assign photograph from a video camera, do the following:

(D Note

List of video camera used for assigning photographs is specified while system configuring (see the Selecting
available cameras in the Access Manager section).

1. Go to editing a user (see the Going to user editing section).
2. Click the right mouse button in user photo area.
3. Select the Assign picture -> From camera in the opened functional menu.

? Editing. Adamson Jessica (creation) N
1] rd Ac level Comment
e Eess ey T Assign picture lect file

Access Level 1 Inherited

From camera

\]/

4. The Select camera window will open.
5. From the Camera drop-down list select the camera from which photograph will be captured (1).

x

3| ok Cancel |

6. If it's required to change the level of video signal compression used for assigning a photograph, select from the Lev
el of compression drop-down list the required level of video signal compression (2). Compression level is
increasing from 0 (without compression) to 5 (maximum compression).

(D Note

Configuring of compression is required while using analog cameras. It's not recommended to use
compression for IP-cameras.

7. Click OK button (3). The Photo from camera window will open.
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10.

11.
12.
13.

1.
2.
3.

¥ Photo from camera

1 Capture parameters 5
Fotate and/or inverse: Capture
2 Do not change QK
3 Show camera number, time of frame and securty r

state

Video from the selected video camera is displayed in the window (1).

If it's required selected the way of frame processing from the Rotate and/or inverse drop-down list (2). the
following ways of frame processing are available:

Do not change (on default).

Rotate 90.

Rotate 180.

Rotate 270.

Inverse horizontally.

Rotate 90 and inverse horizontally.

Inverse vertically.

Rotate 90 and inverse vertically.

The frame is saving without information about camera number, time of frame receiving, without information about
camera arming or disarming (it is defined by color of the frame around camera). If it's required to add this
information to the captured frame with the user image, set the Show camera number, time of frame and

security state checkbox (3).

{D Note

It's recommended to configure rotation and add information to the frame before the image capturing.
Changing of these settings after capturing won't lead to their disappearing from the captured frame.

JQ 0O QOO OTW

Wait for appropriate frame with the user image and click the Capture button (4).
The received frame will display in the (5) window.
Click the OK button (6). The received frame will be assigned as the user photograph.

Assigning a photograph to user from a video camera is completed.
Cropping a photograph

It's possible to crop the assigned photograph in the Access Manager software module.

To crop a photograph, do the following:

Go to editing a user (see the Going to user editing section).
Click the right mouse button on a photograph assigned to a user.
Select the Crop photo in the opened functional menu.

P
Assign picture
Delete photo

4. The Framing window will open.
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o

¥ Framing M=E3

. To select the area which should be stay in the photo click the left mouse button in the required point and stretch

the rectangle marking the selected area.

(D Note

To change the selected area click the left mouse button in the area marked by a rectangle and select the
area again.

To delete selection click the right mouse button on the selected area and select the Clear item.
Click the right mouse button on the selected area and select the Crop item.



¥ Framing

Cropping a photograph is completed.
Deleting a photograph

To delete a photograph, do the following:

1. Go to editing a user (see the Going to user editing section).
2. Click the right mouse button on a photograph assigned to a user.
3. Select the Delete photo in the opened functional menu.

Deleting a photograph is completed.

Adding biometric parameters

Adding biometric parameters (fingerprints, palm vein patterns, etc.) is performed using control readers or biometric ACS
controllers.

To add a user's fingerprints, right-click the user's photo and select Extensions -> Reader.

User card
(20d) 27859

Access level  Comment
"Always" Inherited

Assign picture
Bxtentions (Suprema/Biosmart) F580 control reader 1

'II User 1(1)

A dialog box for adding user biometric parameters opens. This dialog box is different for various equipment in use.
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Operation in this dialog box is described in the corresponding integration module settings guide.

Note.
Select a required reader or controller while configuring Access Manager to make it available in the Extensions list
- see Selecting control readers in the Access Manager.

Transferring a user to a different department in the Access Manager software
module

To transfer a user to a different department, do the following:

1. Go to viewing users list (see the Viewing a list of users section).
2. Click the right mouse button on the name of required user.

Note
To select several users to transfer them to a different department click them the left mouse button holding
the Ctrl key.

3. Select the Change department item in the opened functional menu.

III Access Manager 1

-~ m
@ Deparments @ Time zones (¢ | Access levels

- o, Department 1 A~ )

o Department 2
; Departmert 3
et - De.partment 4

‘ Delete
I Change department I
t' Print access card

n

4. As a result the Search for department window will open. After searching select the department to which user is to
be transferred (see the Working with Search for department window section).
5. As a result the user will be transferred to the selected department.

Transferring a user to a different department is completed.
User search in the Access Manager software module

General information about user search

Searching for users is performed in one of the following ways in the Access Manager software module:

By ID.

By surname.

By card.

By card using a control reader.
By access level.

. General search.

Going to user search

oSUAWN

To go to user search, do the following:

(D Note

Also going to user search is performed by Ctrl+F keys combination - see the Key combinations for working with
objects lists section. While going to user search using the key combination, the Search in department tab will
open where the search condition by the department will be specified.

. Go to viewing users list (see the Viewing a list of users section).

. Click the right mouse button in free area of users list.

. Select the Search item in the opened functional menu. In the opened functional menu select the required way of
search - see the General information about user search section.

WN =
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o [a)

Department 2
‘- Department 3
- Department 4

-

John Smith

View
Sorting

New

Search

User cand

id

Accesslevel  Comment ‘

Bose

Q)

Access level
Extemal 1D
D

Name

Users

Type of department  Main

EEanb B

"Always"

]
Depatment 1

By surname

By number

By card

By card (control reader)
By access level

General search

4. The new tab will be opened for search (1). Name of the tab depends on the selected way of search. The tab
contains the following interface elements:
a. List of search rules (2).
b. List of found users (3).
c. Parameters of the selected user (4).

2 Access Manager 1

-~ [al
Departments @T\memna n Access levels | "ol General search

e [ a

User card

|

Access level

Basic | Additional
=43

d. In case the search is performed by number, surname, card or access level, the corresponding rule will be
specified in the list of rules. It's possible to add search rules to the list if it's required (see the Adding a
search rule section).

e. In case the search is performed by card using a control reader, a window will open, offering to select the
control reader and start the search:

=
o5 Access card reading .

E)

Readertype | BioSmart 4 1.1

[ Start reading

Start reading or select another control reader

In the opened window, click Start reading and present the card to the selected reader device.

Going to user search is completed.
Adding a search rule

While searching for objects in the Access Manager module the following logic operators are available:

1. Logic AND.
2. Logic OR.



Search rules will be combined on the following way:

(Rule11l OR Rule12 OR ... OR Rule 1N) AND
(Rule21 OR Rule22 OR ...Rule 2M) AND

(Rule K1 OR Rule K2 OR ... OR Rule KL)

Where N, M, K, L —some integer number.

Search rules combined by OR operator are displaying in one string. Search rules combined by AND operator are displaying
one over the other.

Sumarme Check case [ Sumame Check case I
IEquaIs j Invert [ IEquaIs j Invert T ar
I Smith I Adamson
Access level Imvert [
or
I;’-‘u:n:ess Level 2 j gl
Name Check case [
IEquaIs j Invert [ ar
I John
Add rule - |

To add the search rule, do the following:
1. Go to the user search (see the Going to user search section).

Sumarme Check caze [
IEquaIs j Invertt | or
| Smith

Add rule I 1 Q |

2. Click the Add rule button (1) to add AND rule or the or button (2) to add OR rule. The Select condition for
search window will open.
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AW

Select condition for search x|

- Sumame

- Access level
- UUser cand
- Name

- Patromymic
- Standard

- Access level assigned by
- Additional information
- Antipassback
- Birth place
- Card expiry date Ll
- Card issued by
- Commencement of card
- Date of card issue
- Date of firing
- Diate of hirng:
- Document
- Driving license
- E-mail address
- Bxtemal 1D
- Number of card loss LI

The user parameters are listed in this window (see description in the Setting user parameters section).
Double click on the name of parameter by which search is to be performed.
The search rule by selected field will be added. Configuring of search rules differs due to type of rule. The following
types of search rules are available:
a. Text field

Sumame Check case [

I Equals j Invertt [ ar
| Smith

Add rule )

i. From the drop-down list (3) select the comparison method of a field value with specified search line.

Comparison Description

method

Equals Search for all users for which a value of the selected field is fully coincides with
the specified search line.

Contains Search for all users for which a value of the selected field contains the specified
search line.

Starts with Search for all users for which a value of the selected field starts with the

specified search line

Ends with Search for all users for which a value of the selected field ends with the
specified search line

ii. Set the Check case checkbox if it's required to consider symbols case while searching (4).
iii. Set the Invert checkbox if it's required to apply the negation of the specified search rule (5). It
means that all users NOT satisfying to the specified search rule will be found if the checkbox is set.
iv. Enter the search line in the field (6).
b. Access level.

Access level 1N et

2
I}'-J:-:ess Level 2 "’I gl

i. Set the Invert checkbox if it's required to apply the negation of the specified search rule (1).
ii. Select value for search from the drop-down list (2).
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To search the required access levels it's possible to click the l—I button. Working with windows of
objects search is described in corresponding sections of this document.
c. User card

|User code 1 I Floom code ¥

2| Room code
3 |Card number

i. If it's not required to consider the room code, delete the Room code checkbox (1). As a result the R
oom code field won't be available for editing.
ii. Ifit's required to use a room code while searching, enter the value in the Room code field (2).
iii. Enter the required card number in the Card number field (3).
d. Department

9 Department 11| invert T

Department Empolyees ':],ﬂ

i. Set the Invert checkbox if it's required to apply the negation of the specified search rule (1).

ii. To search for required department click the l—l button (2). Working with windows of objects
search is described in corresponding sections of this document.

Note.

Search for department is performed only if going to user search was performed by means of
Ctrl+F keys.

e. Time values

1 Date of card issue IMW 18, 2016 ,I 2

In range * Wiiay 20, 2018 LI 3

i. Select the comparison method of the specified value for search with a field value:

Comparison Description
method
Equals Search for all users for which a value of the selected field is fully coincides with

the specified date.

Not equals Search for all users for which a value of the selected field is not coincide with
the specified date

Higher Search for all users for which a value of the selected field more than specified
date

Lower Search for all users for which a value of the selected field less than specified
date

In range Search for all users for which a value of the selected field is in the specified

range of dates

Out of range Search for all users for which a value of the selected field is out of the specified
range of dates

ii. Set the date for search using the calendar (2).The selected value set the start of search interval in
case of using last two comparison ways from the table.
iii. Specify the end of search interval (3) in case of using last two comparison ways from the table.
f. Additional fields

Ravelin Access type 1 Ivert

i REL I ;’I

i. Set the Invert checkbox if it's required to apply the negation of the specified search rule (1).
ii. Select the search value from the Value drop-down list (2).

Adding a search rule is completed.
Start of user search



When all required search rules are specified (see the Adding a search rule section), click the |I| button to start
search.

Found users will display in the list.

@ Access Manager 1 . =10] x|
- ™ fa
P Departmerts {"/‘ Time zones n Access levels Q General search Q General search |
Sumame Check case [ Sumame Check case [ A M_
Equals 'l Invert IEqua\s ‘I Invet ar
I Smith I Adamson -
Access level Invet I Smith Jersmy
or Access level Comment
Access Level 1 Inherted
Iﬁccass Bl j gl H Access Level 1 Temporary, inherited
wwe || a )
Smith John Smith Jeremy (2)

Found users:2
Basic Iﬂddmnnal |

=

E 0. Full name =
Name
Pati

The list of found users can be changed dynamically.

Example. Search by surname was performed and several users were found. If a surname of one of found users will be
changed than this user will be deleted from the search results. Conversely: if a new user will be added with a surname
satisfying to the search rule, than this user will be added to the search results automatically. And the message about
dynamic data changing will display in the line of search results .

Search results were changed while asynchronous
elements update

Parameters of the user selected from the list are displaying in the right part of the Access Manager window.

To close a tab after search completion click the right mouse button on the tab name and select the Close tab item in the
opened functional menu.

@ Access Manager 1

Ty o Q
.\_‘_;j Time zones n Access levels Close tab

(]
ain Departments

[
Deleting a user in the Access Manager software module

Deleting a user is performed as follows:

@ Note

Ctrl+Del n Ctrl+Backspace keys combination can be used apart of the given method. See the Key combinations
for working with objects lists section.

1. Go to viewing users list (see the Viewing a list of users section).
2. Click the right mouse button on a user which is to be deleted.

(D Note

Also it's possible to select several or all users for deleting.
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3. Select the Delete from the opened functional menu.

Iil Access Manager 1

~ ™
o Departments C"} Time zones n Access Ievelsl

[l o Department 1 = 7y

o um Department 2

. © Department 3
[ - | Delete |
-~ Department 4 E

Change department
Print access card

(D Note

Rights for deleting a user can be limited while configuring the Access Manager module. The message about
missing the corresponding rights will be displayed. See also the Rights for users configuring in the Access
Manager section.

4. The confirmation message will display. To confirm deleting of the selected user click the OK button. To cancel
deleting click the Cancel button.

System warning x|

| Do you really want to delete the selected object?

0K I OTmMeHa |

Deleting a user is completed.
Printing a user access card in the Access Manager software module

It's possible to print a user access cards in the Access Manager software module. A print templates creating with the help
of the Template Editor are used (see the Template Editor Utility Operation Guide).

To print a user access card, do the following:

1. Go to viewing users list (see the Viewing a list of users section).
2. Click the right mouse button on the name of required user.
3. Select the Print access card item in the opened functional menu.

- | ()
‘- Delete _

Change department

4. Select the file of template for access card printing using the standard dialog window.

.[:D Note

Templates are created using the Template Editor utility — see the Template Editor Utility Operation Guide.

5. The Print access card window will open where data for printing is displaying.


https://doc.axxonsoft.com/confluence/display/acfaen/Template+Editor+Utility+Operation+Guide
https://doc.axxonsoft.com/confluence/display/acfaen/Template+Editor+Utility+Operation+Guide

7 Print access card

Menu

Print
Exit
Sumame Smit
Nams Jeramy
Department 1

6. Select Menu -> Print to print the access card. Select a printer and start printing of access card.

Note

If a template was sent for printing, the Access Manager module will generate the "Print access card" event. A
user full name, its ID, name of computer from which access card was printed and person initiated printing
(operator working with the Access Manager module) will be specified in event parameters

Printing a user access card is completed.

Performing Emergency Monitoring
General information about Emergency Monitoring

Emergency monitoring is performed on the Regions and areas tab of the Access Manager window.

<2 Access Manager 1 EI@
~ [ B .
‘- Departments @ Tirme zones n Aocess levels ' Region: and areas
E‘"e wmarea H User card
[127) 12345

worki 2
crking area - (205) 34567

Smith John Patric

Access level  Comment

R

B

Sith John Patric: [1]
Additional

4 0. Full name -
M arme Johin
Patronymic  Patric
Surname Smith

4 1. Personal data
Acoess level
Antipazzbac! Mo
Card expiry ¢ Mot zpecified
Card izzued |
Date of card 27.04.2017 14:0E
Drate of firing Mot zpecified

Drate of hiring Mot zpecified
1D 1.2, Total in region: 1 [RriformelLTD:

lean. |

Person whence wihere

] [ | +

The Emergency monitoring includes the following features:

1. Switch over from access-related events in the Event viewer window to the user profile in the Access manager windo
w (see Viewing user profile from an access event in the Access Manager window).

2. Find out the region where user is currently located (see Finding out the region where the user currently is).

3. Find out user list in the specified region (see Viewing the list of users in the region).

4. Switch over to the specified region on the Intellect software Map (see Viewing region on the Map).

At switching between interfaces (e.g. from the Map to the Access Manager, or from the Event Viewer to the Access
Manager, or backwards), an interface object created on the basis of the same Display object as the source interface is
selected for transition.


https://doc.axxonsoft.com/confluence/pages/createpage.action?spaceKey=acfaen&title=Viewing+user+profile+from+an+access+event+in+the+Access+Manager+window&linkCreation=true&fromPageId=136250066

Configuration of the Map, Event Viewer, Display, Area, Region objects is described in the Intellect software.
Administrator's Guide. Operation of these interface objects is described in the Intellect software. Operator's Guide. The
most recent versions of these documents are available in the AxxonSoft documentation repository.

Creating, editing and deletion of the Area and Region objects in Access Manager is also possible — see Creating, editing

and deleting Area and Region objects.
Card number displaying in the Event viewer window for access events

Facility code and card number of the user related to the access event is displayed in the Card column of the Event viewer
window.

Note.
(D This column can be disabled according to the Event Viewer object settings — see Administrator's Guide, the Even
t viewer parameters section. The most relevant version of this document is available in the AxxonSoft

documentation repository.

Ewvent viewer 1 [¥] Shaw filters

[] Filter 2
Source Ewent Region Add. info [rate and time
28.04.207 15:25:42

Feader [v2000)1.1.1 Enter

e [sm0eanirisa

Viewing user profile by an access event in the Event viewer

Switching to the user profile in the Access Manager from Event viewer is possible for Entrance (ACCESS_IN) and Exit (AC
CESS_OUT1) events.

To view user profile in the Access Manager right-click on the corresponding event in the Event viewer window and select
the Show in AC department menu item.

[0 Show s

Event viewer 1

Source Ewent Fegion Add. info Card
Werb< V2000 WC /Rl 11 Contraller disconn...
2N Action executed

Fieader [2000] 1 Smith John Patric

Show in AC department

The Departments tab opens in the Access Manager window. A department to which the user belongs to is selected in
the departments hierarchy, and the user himself is selected in the list.
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o5 Brcess Manager 1 EI

@ Time zones

-~
- Departrents

n X .
n Access levels 7 Fegions and areasz

""" ; Full Hame Mumber  Date of card issue User card
; Smith Joh Patric 1 27.04.2017 14:06:44 (127112345
(205) 34567

Access level  Comment

"Mewver” Inherited

Smith John Patric [1]

Basic | Additional

All=
4 0. Full name -
Mame John F

Patronyriic  Patric
Surname Snith

4 1. Personal data
Access level
Antipazzbacl Mo
Card expiry ¢ Mot specified

m

Card izzued |
@[i] Date of card 27.04.2017 14:06—
Access level "Meyer" [rate of flf.lhg Mat spec!f!ed
[rate of hirng Mot specified
External ID
D 1 Extemal ID
Mumnber of . 0
HENTE Auron e
Tupe of departret Main _Ige phone
Origin
Users 1
Passport nur
Fersannel no
] |E| , F'IN.c.:ode o
|
Note.

It is also possible to find out the user current location — see Finding out the region where the user currently is.

Finding out the region where the user currently is

To find out the user current location, do the following:

1. Find the user on the Departments tab manually or perform the user search (see User search in the Access Manager
software module).
2. Right-click on the user and select the Show location menu item.

<7 Access Manager 1 EI@
C") Time zones

""" < Axxon Full Name Mumber  Date of card issue Uszer card
Smith John Patric 14:06:44 127112345
Delete [205) 34567

-~
- Drepartments

n = .
n Access levels w Fegions and areas

Change departrnent Access level  Comment

Print access card "Never Inherited

Show location

Smith John Patric (1]

Basic | Additional

1=

4 0. Full name
Mame John
Patranyniic  Patric
Surname Smith

4 1. Personal data
Arccess level
Antipazzbac] Mo
Card expiny ¢ Mot specified
Card izsued |

[g]&] Date of card 27.04.2017 14:06—

[rate of fiing Mot zpecified

[rate of hiring Mot zpecified

External I

Murnber of . O

Office phone

Origin

Fazzport nur

Personnel no

FIN code

»

m

Acocess level “MNever”
Estemal ID

0] 1

Marme AxKn
Tupe of departmer Main
Users 1

« [m] »

3. The Regions and areas tab opens. The region where the user is currently located is selected in the regions and
areas hierarchy while the user himself is selected in the list of persons located in this region.
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) [ = ]
i . Region: and areas
- Departmentsl @ Time zonesl 1 | Access Ievels| v gJ

=gl New area = User card

Dutside [127)12345

‘wiorking area X
- (208) 34567

Srrith John Patric ‘

Access level  Comment

YT} M

Smith John Patric (1]

Basic | Additional

51|
4 0. Full name -
M arme Jahin

Patroryriic Patric
Surname Smith

4 1. Personal data
Access level
Antipazzbac] Mo
Card expiny ¢ Mot specified
Card iszued |
Date of card 27.04.2017 14:0€
[rate of firing Mot specified
[rate of hiing Mot specified

leom. |

10 1.2 Tatal in region: 1 [ErifoellTR
Person Wwhence where Actual time
iSmith John Patric Outside Wworking area 28.04.2017 15:25:42
Smith John Patric ‘wiorking area Outside 28042017 15:25:47

If the user location is undefined, the corresponding message is displayed.

Regions and areas

Io User Forerrian Suian lacation i§ undefined sk the moment

| ok

Defining the user current location is completed.
Viewing the list of users in the region
Switch to viewing users in the region in one of the following ways:

1. From the ACFA-Intellect Map, if the region is added to the Map. For that, right-click on the region and select the Sh
ow in the Access Manager menu item.

Wiorking area1.1]

,‘} -
o Working area[1.1]

A

Control objects
Disarm
Classify alarm

Showe in AC departrment

2. Select the region manually in the Regions and areas tab of the Access Manager window.

As a result, the list of users in the selected region is displayed. The information panel in the lower part of the regions and
areas hierarchy displays the identifier of the selected region or ares and the number of users, that are currently located in
this region or ares.
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<7 Access Manager 1

@ Time zones

Fegions and areas

= Depatment B sccessievets| @
- epartments n ccess levels "

Bg Mew area
Outside H
P

Srnith John Patric

10 1.1, Total in region: 1

User card

‘ Access level  Comment

Basic | Additional
NE

Perzon whence
Smith John Patric Outside
Smith John Patric Wwhorking area
Smith John Patric Outside

where Actual time
wiorking area 2804207 15:25:42

Outside 28.04. 2017 15:25:47
wiorking area 2804207 15:3857

In the lower part off the Regions and areas tab there is a log of passes of all users registered in the system. The list of
users in the region is displayed on real-time basis, while the passes of users between regions are displayed in the log.

Note.

This data on passes is given for information only, it is not recorded in a separate database.

To view the passed user in the current region on the Regions and areas tab, right-click on the required event and select
the Show location item in the menu opened. To view the passed user in his or her department on the Departments tab,

select the Show in department item in the above menu

whence

Person

Smith John Patric
Smith John Patric
Smith John Patric

Showe location

Showe in departrment

where Actual time

Working area 28.04.2017 15:25:42

28042017 15:3357

“whorking area

On th Regions and areas tab the same actions with a user as in the Departments tab are available (see Working with

users in the Access Manager software module).

To view the user profile on the Departments tab, select the Show in department item in the user functional menu.
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CF Access Manager 1

~

) .
. Regionz and areas

1D 1.1, Total in region: 1

Print access card
Show location

Show in departrment

- Departments C") Time zones a Accesslevels|
Bé Hew =3 H Usger card
\?Jtif?ng area X e
Dielate (205) 34567
Change department
Access level  Comment

YT} Mol )

Sraith J ok Patric: [1]

Basic | Additional

=

4 0. Full name
Mame John
Patronymic  Patric
Sumame Smith

4 1. Personal data
Acocess level
Antipazzbac! Mo
Card expiry ¢ Mot specified
Card issued |
Drate of card 27.04.2017 14:0E
Drate of firing Mot specified
Drate of hiring Mot zpecified

»

m

Lok, LI
Perzon whence wihere Actual time
Smith John Patric Outside ‘wiorking area 28042017 152542
Smith John Patric ‘wiorking area Outside 20042017 15:25:47
Smith John Patric Outgide wiorking area 28042017 15:38:57

Viewing region on the Map

To view a region on the Map, right click on the corresponding object in the hierarchy and select the Show on map item in

the menu opened.

2 Access Manager 1

Camn,
- epartments

@ Time zones

M
n Access levels

= ]
v Regions and areaz

B* Mew area
Outside

(an)

Delete

Showe on rmap

100 1.7, Total in region: 1

h John Patric

[F=%ECH
User card
[127)12345
[2085) 34567
Access level  Comment

B R

Smith John Patric [1]

Basic | Additional

A=

4 0. Full name
M arme Johin
Patrorwmic  Patric
Surnarne Srrith

4 1. Personal data
Access level
Antipazsbacl Mo
Card expiry ¢ Mot specified
Card izzued |
Date of card 27.04.2017 14:0€
[rate of fiing Mot specified
[rate of hing Mot specified

»

m

Person

Smith John Patric
Smith John Patric
Smith John Patric

Wwhence

Outside
‘wiorking area
Outside

| = L1
where Actual time
‘Wwiorking area 2804207 152542
Outside 28.04.20017 15:25:47
‘wiorking area 2804207 15:38:57

As a result, the region is selected in the Map window and the region icon blinks twice.




Warking area[1.1]

Ff.

Creating, editing and deleting Area and Region objects

Note.
(D Creating, editing and deleting areas and regions can be done without using the Access Manager with the tools of

the base Intellect software. See Intellect software. Administrator's Guide. The most recent version of this
document is available in the AxxonSoft documentation repository

Creating areas
An Area object is created in the following order:

1. Go to the Regions and areas tab.

©2 Access Manager 1
" b (5) 1 4 sccesslevels| | Regions and
epartments Ime Zones ccess levels v equong and areas
an - (1] V

EI--* Mew area H 1

2| Outside

Smith John Patric

‘ Create area | 2

2. Right-click in the regions hierarchy area free from objects.
3. In the menu opened select the Create area item.
4. The Edit area properties dialog box opens.

.:, Edik area properties !
M arme Mew araal 1

2
Senve ][ Cancel ]

5. In the Name field enter the name of the created Area object (1).
6. Click Save (2).

The area is created.
Creating regions

The region is created in the following order:

1. Go to the Regions and areas tab.
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C% fccess Manager 1

~ ™ S .
Diepartments @ Time zones focess levels| % Fegions and areas
am [ 1 v

B* New area 1
¢ b Outside

] Waorking area

Y New arca

Create region 2
Delete

Show on map

I

2. Right-click on the area under which the region is to be created.
3. In the menu opened select the Create region item.

4. The Edit region properties dialog box opens.

. Edit region properties e
Hame i region
1
Comment 2
3 sae ] | Cancel

5. In the Name field enter the name of the created Region object (1).
6. In the Comment field enter description of the created region if necessary (2).
7. Click Save (3).

The region is created.
Editing areas and regions

To edit area or region, double-left-click on it.

The Edit area properties/Edit region properties dialog box opens. Working with this dialog box is described in the Crea
ting areas or Creating regions section correspondingly.

Deleting areas and regions

To delete an area or region, right-click on it and select the Delete menu item.

25 Access Manager 1

-~ ™ k .
Departrents @ Time zones Access levels| ' Regions and areas
£ P n ]

Elﬁ Mew area
Z Outside

P -l Working area
- Mew area 2

Delete

Showy on map

The System warning dialog box opens. Click OK to delete the Area or Region, or Cancel to abort the operation.



Systern warning -t |

'a Do wou really want to remowve this Zone/Region?

QK JTmeHa

When you delete an area, all the child regions in it are deleted.

Deleting area or region is completed.

Appendix 1. Description of the Access Manager interfaces
The Access Manager object settings panel

The figure shows the Access Manager interface object settings panel.

N | [Focess Manager 1 | Departments | Readers | Cameras | Dthers|
: = = &ll departments
Dizplay 3 || Dizable Depattment 1
4 I Dizplay 1 I Department 2
Departrment 3
Position Department 4
|| Fix position | 5 Departrment 5
b ariitior 1 [ L[] Department &
il &0 i 1] 8
22
3 | A0 H: a0 10
Access levels settings
1 Create
— i
12[[V]Delet= 13

14 Uzer zettings
[/] Create
15[ IDekte 16

TEale Lsers with S0 I 17

Departments settings
[/] Create
18[[W  Delete 20

New departments are visible in root | 21

—
L)

Apphy Cancel

Departments tab
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Edit

Delate

Uzer settings

Create _
Delete Edit

Create users with APE

Departmentz settings
Create

Delete Eet
Mew departments are visible in root

Departments | Feaders | Cameras | Others

| Canfirm card entered by operator | 23

F580 control reader 1

Gate Parking access point1

Gate Parking access point 2

Suprema BioMini 1

<R

Readers tab

Dizplay 1 -
Pogzition
Fix pogition

Fdonitar l‘l

e
LR 50 50

2

Access levels settings

Create

/| Edit

Delete L
User settings

Create _

Delete Edit

Create users with AFE
Departments settings

Create .

Delete Edit

Mews departments are visible in root

| Departments | Headers| Cameras |Dthers

Cameras Use Gateway
Cameral I7 Yideogate 1
Camera 2 I7

Camera 3 I_

Cameras tab
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1 Access Manager 1

Dizplay || Disable

Dizplay 1

Departments I Readers | Eamerasl Others |

Critena of user parameters duplicates

Full Mame

[Sumame, harne

Euternal ID

29

Position
[] Fis position
Monitor 1
RO Y

al H:

50
50

b
LR
Access levels settings

Create
41 Edit

Delete

Uszer zethings

Create .
Delete Edit

[] Create uzers with APE

Departments settings

Create
] Edi

Delete
Mew departments are wisible in rook

Apphy Cancel

Others tab

Wehicle license plate

30

31

Module version 1.0.7.11

The following table shows the elements in the Access Manager settings panel.

N2 Parameter Parameter
name setting
method

1 ID field Automatically

2 Name field Setting the
value in the
field

3 Disable checkb Settings

ox checkbox

4  Display drop-d  Selecting the

own list value in the
list
Position group
5 Fix position ch Settings
eckbox checkbox

6  Monitor drop-d
own list

Selecting the
value in the
list

Setting the
value in the
field

Setting the
value in the
field

Setting the
value in the
field

Description

Displays the identification
number of the Access Manager
interface object in the system

Sets the number of the Access
Manager object in the system

Sets the Access Manager objec
t state in the system (enabled or
disabled)

Sets the Display parent object
for the Access Manager object

Is used if it's required to specify
coordinates of the Access
Manager window and forbid its
moving

Sets the number of monitor on
which the Access Manager win
dow will be displayed

Sets X coordinate of the upper
left corner of the Access
Manager window

Sets Y coordinate of the upper
left corner of the Access
Manager window

Sets the Access Manager wind
ow width

Data type Default
value

Whole -

nonnegative

number

Latin, Cyrillic  Access

and special Manager

symbols

Boolean type  No

Name of Parent Di

created Displ splay na

ay objects me

Boolean type  No

List of Monitor 1

accessible

computer

monitors

% of screen 0
width

% of screen 0
height

% of screen 0
width

Value range

Depends on number of
accessible Access Manager obj
ects in the system

Case-insensitive character string
(letters, digits, special symbols
excepting > and <).

From 1 to 60 symbols

Yes - the Access Manager obje
ct is not used in the system.

No - the Access Manager obje
ct is used and active

Depends on the number of the D
isplay objects

Yes - position of the Access
Manager window is fixed.

No - position of the Access
Manager window can be
changed.

Depends on the number of
connected computer monitors

From 0 to M*100, where M is a
number of computer monitors

From 0 to M*100, where M is a
number of computer monitors

From 0 to M*100, where M is a
number of computer monitors



10 H: Setting the

value in the

field

Access level settings group

11 Create checkbo Settings
X checkbox
12 Delete checkbo Settings
X checkbox
13 Edit checkbox Settings
checkbox
User settings group
14 Create checkbo Settings
X checkbox
15 Delete checkbo Settings
X checkbox
16 Edit checkbox Settings
checkbox
17 Create users Settings
with APB chec checkbox

kbox

Departments settings group

18 Create checkbo Settings
X checkbox

19 Delete checkbo Settings
X checkbox

20 Edit checkbox Settings
checkbox

Sets the Access Manager wind
ow height

Sets possibility to create access
levels in the Access Manager w
indow

Sets possibility to delete access
levels in the Access Manager w
indow

Sets possibility to edit access
levels in the Access Manager w
indow

Sets possibility to create users in
the Access Manager window

Sets possibility to delete users in
the Access Manager window

Sets possibility to edit users in
the Access Manager window

Sets default value for
antipassback parameter

Sets possibility to create
departments in the Access
Manager window

Sets possibility to delete
departments in the Access
Manager window

Sets possibility to edit
departments in the Access
Manager window

% of screen
height

Boolean type

Boolean type

Boolean type

Boolean type

Boolean type

Boolean type

Boolean type

Boolean type

Boolean type

Boolean type

Yes

Yes

Yes

Yes

Yes

Yes

No

Yes

Yes

Yes

From O to M*100, where M is a
number of computer monitors

Yes - creating access levels
from the Access Manager wind
ow is allowed.

No - creating access levels from
the Access Manager window is
forbidden.

Yes - deleting access levels
from the Access Manager wind
ow is allowed.

No - deleting access levels from
the Access Manager window is
forbidden.

Yes - editing access levels from
the Access Manager window is
allowed.

No - editing access levels from
the Access Manager window is
forbidden.

Yes - creating users from the Ac
cess Manager window is
allowed.

No - creating users from the Ac
cess Manager window is
forbidden.

Yes - deleting users from the Ac
cess Manager window is
allowed.

No - deleting users from the Ac
cess Manager window is
forbidden.

Yes - editing users from the Acc
ess Manager window is allowed.

No - editing users from the Acc
ess Manager window is
forbidden.

Yes - users are created with
antipassback on default.

No - users are created without
antipassback on default.

Yes - creating departments from
the Access Manager window is
allowed.

No - creating departments from
the Access Manager window is
forbidden.

Yes - deleting departments from
the Access Manager window is
allowed.

No - deleting departments from
the Access Manager window is
forbidden.

Yes - editing departments from
the Access Manager window is
allowed.

No - editing departments from
the Access Manager window is
forbidden.
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21 New
departments
are visible in

root checkbox

Departments tab

22 Departments
tree

Readers tab

23 Confirm card
entered by
operator check
box

24 List of readers

Cameras tab

25 Cameras colum
n

26 Use checkbox

27 Gateway
drop-down list

Others tab

28 Full name drop
-down list

29 External ID ch
eckbox

30 Vehicle
license plate c

heckbox

31 Module

version field

Settings
checkbox

Settings

checkbox

Settings
checkbox

Settings
checkbox

Automatically

Settings
checkbox

Selecting the
value in the
list

Selecting the
value in the
list

Settings
checkbox

Settings
checkbox

Automatically

Sets availability of new created
departments in the Access
Manager hierarchy root

Sets available departments in
the Access Manager window

Sets requirement to confirm
card code entering by operator

Sets list of control readers used
for entering user access cards

Displays list of Camera objects
created on the Hardware tab of
the System settings dialog
window

Sets possibility to use camera for
assigning photo to user in the Ac
cess Manager window

Sets the Gateway object used
for receiving video signal from
camera

Sets the way of defining of users
record duplicates by name,
surname, patronymic

Indicates whether the users
records should be checked for
external ID duplicates

Indicates whether the users
records should be checked for
vehicle licence plate number
duplicates

Displays the current version
number

Boolean type

Boolean type

Boolean type

List of created
reader objects
in the system

List of created
Camera objec
ts in the
system

Boolean type

List of created
Gateway obj
ects in the
system

List of
available
combinations

Boolean type

Boolean type

Number

Yes

Set of
boolean
variables

No

Set of
boolean
variables

Names of
Camera
objects

No

Names of
Gateway
objects

Not used

No

No

Current
version
number

Yes - new departments are
available in the Access
Manager hierarchy root

No - new departments are not
available in the Access
Manager hierarchy root

Department will be available in
the Access Manager window if
checkbox is set close to it

Yes - operator confirmation is
required to assign access card
to user.

No —-operator confirmation is not
required to assign access card to
user.

The reader will be available to
enter user access card if
checkbox is set close to it

Depends on number of
accessible Camera objects in the
system

Yes - camera can be used for
assigning photo.

No - camera can't be used for
assigning photo

Depends on number of
accessible Gateway objects in
the system

Not used - adding users with
the same full name is allowed.

Surname, name - adding users
with the same name and
surname and different
patronymic is forbidden.

Surname, nhame, patronymic
- creating users with the same
full name is forbidden.

Yes - creating users with the
same external ID is forbidden.

No - creating users with the
same external ID is allowed.

Yes - creating users with the
same license plate number is
forbidden.

No - creating users with the
same license plate number is
allowed.

Depands on the current version
of the module.

The User rights in Access Manager object settings panel

The figure shows the User rights in Access Manager interface object settings panel.



" ||1 A IILIser rights in Access Manager

Aeoceszs Manager

Il Disatle

4 || Access Manager 1

Departments | Standard fieldz | Additional fields

B- E &ll departments

= [#] Department 1
- [#] Mew department 1
Departrment 2

I zer nights
5' |1zer permizzions 1 hd I

6
[

¥ Delete

Access levels sethings
¥ Create v Edit |8

Uzer settings

Department 3
... [#] Department 4

13

Ol ¥ Create v Edit |11
v Delete
10
14 15 16
¥ Create v Edi ¥ Delete
1 2 W Mew departments are wisible in root
Apply || Cancel
Departments tab

|1.1 IUser fights in Access Manager Departments _Standard fisids |.-i‘-.|:||:|iti|:|nal ﬁEldSl

Aooeszs Manager [T Dizable Do Ikl -
Surname Hidden
|.-’-'-.|:n:ess b anager 1 i T Hidden
Ilzer rights Patronymic Hidden
ILlser peErmizziong 1 j Personnel number Hidden
— Access levels setings External ID Hidden
¥ Create v Edi Position Hidden
¥ Delete Date of hiring: Hidden
S Date of firing Hidden
¥ Create [V Edit Temporary AL activation date Hidden
[V Delete Temporary AL expiry date Hidden
Access cards Hidden
Commencement of card Hidden
Card expiry date Hidden
Date of card issue Hidden
Mumber of card loss Hidden
1 ? PIM code Hidden

J Access levels

Hidden g

¥ Mew departments are wisible in root

18

Standard fields tab

Note

The list of fields displaying in the Additional fields tab depends on used integration module.

The following table shows the elements in the User rights in Access Manager settings panel.
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N2 Parameter Parameter
name setting
method

1 ID field Automatically

2 Name field Setting the
value in the
field

3 Disable chec Settings

kbox checkbox

4  Access
Manager dro
p-down list

Selecting the
value in the
list

User rights group

5 Userrightsd
rop-down list

Selecting the
value in the
list

Access level settings group

6 Create check Settings
box checkbox

7 Delete check Settings
box checkbox

8  Edit checkbox Settings
checkbox

User settings group

9 Create check
box

Settings
checkbox
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Description

Displays identical number of the Use
r rights in Access Manager interfa
ce object in the system

Sets the number of the User rights
in Access Manager object in the
system

Sets the User rights in Access
Manager object state in the system
(enabled or disabled)

Sets the Access Manager parent
object for the User rights in
Access Manager object

Sets user rights in the ACFA-Intellect
software package, corresponding to
the configured User rights in
Access Manager object

Sets possibility to create access
levels in the Access Manager windo
w while working with configured
operator rights

Sets possibility to delete access
levels in the Access Manager windo
w while working with configured
operator rights

Sets possibility to edit access levels
in the Access Manager window
while working with configured
operator rights

Sets possibility to create users in the
Access Manager window while
working with configured operator
rights

Data type

Whole
nonnegative
number

Latin, Cyrillic
and special
symbols

Boolean type

Names of
acceptable Acce
ss Manager obj
ects in the
system

Name of created
User
permissions ob
jects

Boolean type

Boolean type

Boolean type

Boolean type

Default
value

User rights in
Access
Manager

No

Name of the
Access
Manager pa
rent object

Depends on
created User
permissions
objects

Yes

Yes

Yes

Yes

Value range

Depends on number of
accessible User rights
in Access Manager obj
ects in the system

Case-insensitive
character string (letters,
digits, special symbols
excepting > and <).

From 1 to 60 symbols

Yes - the User rights
in Access Manager obj
ect is not used in the
system.

No - the User rights in
Access Manager object
is used and active

Depends on number of A
ccess Manager objects
in the system

Depends on created Use
r permissions objects

Yes - creating access
levels from the Access
Manager window is
allowed.

No - creating access
levels from the Access
Manager window is
forbidden.

Yes - deleting access
levels from the Access
Manager window is
allowed.

No - deleting access
levels from the Access
Manager window is
forbidden

Yes - editing access
levels from the Access
Manager window is
allowed.

No - editing access
levels from the Access
Manager

Yes - creating users
from the Access
Manager window is
allowed.

No - creating users from
the Access Manager wi
ndow is forbidden.



10 Delete check Settings Sets possibility to delete users in the
box checkbox Access Manager window while
working with configured operator
rights

11 Edit checkbox Settings Sets possibility to edit users in the A
checkbox ccess Manager window while
working with configured operator
rights

Without group

12 New Settings Sets availability of new created
departments checkbox departments in the Access
are visible in Manager hierarchy root
root checkbo
X

Departments tab

13 Departments  Settings Sets available departments in the Ac
tree checkbox cess Manager window while
working with configured operator
rights
14 Create check Settings Sets possibility to create
box checkbox departments in the Access

Manager window while working with
configured operator rights

15 Delete check Settings Sets possibility to delete
box checkbox departments in the Access
Manager window while working with
configured operator rights

16 Edit checkbox Settings Sets possibility to edit departments
checkbox in the Access Manager window

Standard fields tab

17 Name of Automatically List of available user fields
field column
18 Field Selecting the = Sets availability of filed for viewing
availability for value in the and editing
viewing and list
editing

Boolean type Yes
Boolean type Yes
Boolean type Yes
Boolean type Set of
boolean
variables
Boolean type Yes
Boolean type Yes
Boolean type Yes

Accessible types Hidden
of field
availability

The Type of department object settings panel

The figure shows the Type of department interface object settings panel.
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Yes - deleting users
from the Access
Manager window is
allowed.

No - deleting users from
the Access Manager wi
ndow is forbidden

Yes - editing users from
the Access Manager wi
ndow is allowed.

No - editing users from
the Access Manager wi
ndow is forbidden.

Yes - new departments
are available in the Acce
ss Manager hierarchy
root

No - new departments
are not available in the A
ccess Manager hierarch
y root

Department will be
available in the Access
Manager window if
checkbox is set close to
it.

Yes - creating
departments from the Ac
cess Manager window
is allowed.

No - creating
departments from the Ac
cess Manager window
is forbidden.

Yes - deleting
departments from the Ac
cess Manager window
is allowed.

No - deleting
departments from the Ac
cess Manager window
is forbidden.

Yes - editing
departments from the Ac
cess Manager window
is allowed.

No - editing
departments from the Ac

cess Manager window
is forbidden.

See the Setting user
parameters section

Hidden
Read only
Edit
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1 I1 8 IlType of department 1.1 I

Aoceszs Manager

|] Aocezs Manager 1

I” | Dizable

|con | leon O

Template |

|
[

>

T | Apply f
Standard fields§ additional fields | 4] 10
Mame of field Cateqory 2
Surname Edit 0. Full name
Mame Edit 0. Full name
Patronymic Edit 0. Full name
Personnel number Hidden 1. Personal data
External ID Edit 1, Personal data
Position Edit 1. Personal data
Date of hiring: Edit 1. Personal data
Date of firing Edit 1. Personal data
Temporary AL activation date Hidden 1. Personal data
Temporary AL expiry date Hidden 1. Personal data
Access cards Edit 1. Personal data
Commencement of card Edit 1. Personal data
Card expiry date Hidden
et ol cacdicong Hidden S
Note

The list of fields displaying in the Additional fields tab depends on used integration module.

The following table shows the elements in the Type of department settings panel.

N2 Parameter Parameter
name setting
method
1 ID field Automatically
2 Name field Setting the
value in the
field
3 Disable chec Settings
kbox checkbox
4  Access Selecting the

Manager dr  value in the
op-down list  list

Without group

5

Icon drop-d  Selecting the
own list value in the
list

Template dr Selecting the

op-down list  value in the
list

Apply butto  Clicking the

n button

Standard fields tab

Description

Displays identical number of
the Type of department int
erface object in the system

Sets the number of the Type
of department object in the
system

Sets the Type of
department object state in
the system (enabled or
disabled)

Sets the Access Manager p
arent object for the Type of
department object

Sets icon used for displaying
department in the tree of the
Access manager window

Sets fields available for
viewing and editing for some
users category

Applying the selected
template

Data type Default
value

Whole nonnegative -

number

Latin, Cyrillic and Type of

special symbols department

Boolean type No

Names of
acceptable Access
Manager objects in
the system

ccess

Name of accessible Icon O

icons

Name of accessible -
templates

Name of the A

Manager par
ent object

Value range

Depends on number of
accessible Type of
department objects in the
system

Case-insensitive character
string (letters, digits, special
symbols excepting > and <).
From 1 to 60 symbols

Yes - the Type of
department object is not
used in the system.

No - the Type of
department object is used
and active

Depends on number of Acce

ss Manager objects in the
system

Icon O - Icon 29

Employees
Vehicle

Visitors



8 Name of Automatically List of available user fields

field column

9  Field Selecting the = Sets availability of filed for
availability value in the viewing and editing
for viewing list
and editing

10 Category fie Setting the Sets name of a category in
Id value in the which field will display on
field the Access Manager user
panel

Accessible types of
field availability

Latin, Cyrillic and
special symbols

Hidden

See the Setting user
parameters section

Hidden
Read only
Edit

Any character string

Appendix 2. Configuring a visitor management system
without the Access Manager interface window

General information on ACFA Intellect objects related to the

visitor management system

Some of the ACFA Intellect software objects can be used to set up the visitor management system without the Visitor

Management System window, namely:

1. User and Department objects created on the Users tab of the System settings dialog box.

2. Access level and Time zone (which corresponds both to time zone and shift work in the VMS) objects created on

the Programming tab of the System settings dialog box.

Note.
@ Settings panel of the Time zone object is described in the Intellect software. Administrator's Guide for this object

is used in the Intellect software not only for setting up the visitor management system but also for other

purposes.

Most of the settings in the settings panels of these objects duplicate the respective settings of the Visitor Management
System objects. Thus, the setting of the listed objects is designed to operate in the absence of the Visitor Management

System module in the system (if the module is not purchased). However, as practice shows, the Visitor Management
System module provides a much more user-friendly interface to perform similar tasks and also has an enhanced
functionality, so it is recommended to use the Visitor Management System module.

Settings panel of the Department object

The picture shows the settings panel of the Department object.

~ Access control

{ Aocess level | Accesz Level 1

3

Aooess Level 2
Aocess Level 1

~ "Rubezh" subzystem

Aocess level |

The table gives the description of the Department object settings.

Method for setting the parameter
value

# Parameter
name

1 Identification Automatically
number field

90

Parameter
description

Shows the
identification
number of the Dep
artment object in
the system

Default
value

Value range

Depends on number of Departm
ent objects in the system


https://doc.axxonsoft.com/confluence/pages/viewpage.action?pageId=84354171
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2 Name field

3 Disable check

box

4 Access level
dropdown list

5 List of access
levels

6 Region dropd
own list

7 Access level
dropdown list

Enter the value in the field

Is set in a checkbox

Is selected in the list

Sets the name of
the Department ob
ject in the system

Sets the status
(enabled/disabled)
of the Department
object in the system

The Access control group

Sets the
department's access
level

Is selected in the list. To add a new row
in the table click left mouse button in any
empty space of the table and press

Sets the
department's access
level list

"down" arrow on the keyboard.

The "Rubezh" subsystem group

Is selected in the list

Is selected in the list

Sets the Region obj
ect for the Rubeg-0
7 ACS (discontinued
)

Sets the access
level for the Rubeg-
07 ACS (discontinue
d)

Settings panel of the User object

The pictures show the settings panel of the User object.

|2

Additional infa

C o 3

—

[epartment 1

|

i "RAubezk" subspgtern
Rights far regionz management

Access level

4
1]

(Grnup

v\d

L

Department

False

Lzer locked )

Additional cards

8

¥Tbiect code

Walid bl |

\...ékllt

10

15

16

Access control I Access Levels !

Settings panel of the User object The Access control tab.

A line representing a sequence of
any symbols

(letters, digits, service characters
apart from > and < symbols), not
case-sensitive.

Number of symbols - from 1 to
60.

True - the Department object is
enabled and in use

False - the Department object
is disabled and not in use

The list of Access level objects
created in ACFA Intellect (on the
Programming tab or via the
VMS) and also Full access and A
ccess forbidden levels.

The list of Access level objects
created in ACFA Intellect (on the
Programming tab or via the
VMS)

The list of Region objects in the
ACFA Intellect software

The list of Access level objects
created in ACFA Intellect (on the
Programming tab or via the
VMS) and also Full access and A
ccess forbidden levels.



i Juser
Department I~ Disable
| Departrnent 1 j

Time2 ™

o020 J

19 20

Settings panel of the User object The Access levels tab.

The table gives the description of the User object settings.

# Parameter Method for Parameter description Default Value range
name setting the value
parameter
value
1 Identification Automatically Shows the identification - Depends on number of User objects in the
number field number of the User object in system
the system
2  Name Field Enter the Sets the name of the User obj User A line representing a sequence of any symbols
value in the  ect in the system (letters, digits, service characters apart from >
field and < symbols), not case-sensitive.

Number of symbols - from 1 to 60.

Do not use rs as username when registering
Operator accounts as this name is used by
default in Intellect Web Report System.

3 Disable Check Issetina Sets the status False True - the User object is enabled and in use
box checkbox (enabled/disabled) of the User
object in the system False - the User object is disabled and not in
use

4 Department Is selected in Sets the parent Department  Name of the Depends on number of Department objects in

dropdown list  the list object for this User object parent Depa the system
rtment obje
ct
5 Additional info  Enter the Additional user information - A line representing a sequence of any symbols
field value in the
field

The "Rubezh" subsystem group

6 Rights for Is selected in Sets the permissions for the R - 0-16
region the list ubeg-07 ACS (discontinued)
management regions management
dropdown list
7  Access level Is selected in Sets the access level for the R - The list of Access level objects created in ACFA
dropdown list  the list ubeg-07 ACS (discontinued) Intellect (on the Programming tab or via the

VMS) and also Full access and Access
forbidden levels.

The Access control tab
8 Userlocked c Issetina Is set if the user is to be False True - the user is locked.

heckbox checkbox locked.
False - the user is active.
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10

11

12

13

14

Antipassback
checkbox

Object code fi
eld

PIN field

Permanent
card field

Temporary
card field

Valid till field

Is setin a
checkbox

Enter the
value in the
field

Enter the
value in the
field

Enter the
value in the
field

Enter the
value in the
field

Enter the
value in the
field

Is set if the user is not allowed
to go twice through the reader
in the same direction.

Facility code of the user's
access card

PIN-code of the user's access
card

User's access card number

User's temporary access card
number

Date the user's access card
expires (which is specified in t
he Permanent card field)

Additional cards table

False

True - anti-passback enabled.

False - anti-passback disabled.

Depends on the type of cards in use.

Depends on the ACS in use

Depends on the type of cards in use.

Depends on the type of cards in use.

Date in DD.MM.YYYY format

Note. In the Visitor Management System, the additional cards are specified separated by spaces after the parameters of the main card.

The functionality of assigning users additional cards is to be supported by the hardware.

15

16

17

18

19

20

Settings panel of the Access level object

The picture shows the settings panel of the Access levelobject.

Object code fi
eld

Card code fiel

d

Access type d
ropdown list

A.L. dropdown
list

Datel and Ti
mel fields

Date2 and Ti
me?2 fields

Enter the
value in the
field

Enter the
value in the
field

Is selected in
the list

Is selected in
the list

Enter the
value in the
field

Enter the
value in the
field

Facility code of the user's
additional access card

Number of the user's
additional access card

The Access levels tab.

Sets the way of choosing
access level for user

Can be used if the List value is
selected in the Access type li
st. Sets the user's access level
list

Allow to set the beginning date
of the temporary access level.

Allow to set the ending date of
the temporary access level.

Depends on the type of cards in use.

Depends on the type of cards in use.

Group - the employee is assigned the access
level of the department

Access forbidden - the employee is not allowed
to access, even if the department assigned a
different access level, allowing access

Full access - the employee has a full access ,
even if the department assigned a restricted
access level

List - the employee is assigned a list of access
levels having priority over the department access
level.

The list of Access level objects created in ACFA
Intellect (on the Programming tab or via the
VMS)

Date in DD-MM-YY and time in HH:MM:SS
format.

Date in DD-MM-YY and time in HH:MM:SS
format.



1

IAccess Level 1

1 2

3 I Disable

~ Awailable readers

Access paint | Time Zone | Arm | Disarml Tranzmit cards |
|ﬂ o O O

4 5 6 7 8

< |

[ |

Apply Cancel

The table gives the description of the Access level object settings.

#

1

Parameter
name

Identification
number field

2 Name field

Disable check
box

Access point
dropdown list

Time zone dr
opdown list

Arm checkbox

Disarm check
box

Method for

setting the

parameter
value

Automatically

Enter the
value in the
field

Is setin a
checkbox

Is selected in
the list

Is selected in
the list

Is setin a
checkbox

Is setin a
checkbox

Parameter description

Shows the identification number of the Access level objec
tin the system

Sets the name of the User object in the system

Sets the status (enabled/disabled) of the Access level obj
ect in the system

Card reader through which the employees are performing
access

Time zone, during which the access will be allowed
through the corresponding access point

Enables arming of access point after presenting access
card by user.

Note. This function should be supported by hardware.

Enables disarming of access point after presenting access
card by user.

Note. This function should be supported by hardware.

Default
value

Access

level

False

False

False

Value range

Depends on number of Ac
cess level objects in the
system

A line representing a
sequence of any symbols
(letters, digits, service
characters apart from >
and < symbols), not
case-sensitive.

Number of symbols -
from 1 to 60.

True - the Access level
object is enabled and in
use

False - the Access level
object is disabled and not
in use

Depends on the readers
created in the system

Always
Never

The list of Time zone obj
ects created in the
system

True - access point is
armed after presenting
access card by user

False - access point is
not armed after
presenting access card by
user

True -access point is
disarmed after presenting
access card by user

False - access point is
not disarmed after
presenting access card by
user
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8 Transmit Issetina Enables sending access cards to controller after presenting False True - access cards are

cards checkbo checkbox access card by user. sent to controller after

X presenting access card by
Note. This function should be supported by hardware. user.
Function of this checkbox can differ depending on the False - access cards are
integration module in use. For example, in PERCo-S-20 not sent to controller
integration this checkbox enables commission mode. after presenting access

card by user.

Appendix 3. Settings for proper operation of the Access
Manager module in a distributed architecture

The Access Manager module loads the components required for its proper operation directly from the SQL Server database
of the Intellect Server. This causes some problems for module operation in distributed architectures, based on a variety of
combinations between the Intellect Server, the Remote Admin Workstation, and the Client (see Configuration of distributed
architecture).

In particular, attempting to run the Access Manager module remotely from a computer with a Client installation leads to
inability of the Access Manager to display the objects, which are loaded from the Intellect Server DB, e.g. the lists of users
and departments. In order to circumvent this issue, the distributed architecture administrator is recommended to do the
following:

1. On the computer with a Client installation:
a. Install the SQL Server database server. Thus, the SQL Server on a computer with a Client installation will be
able to connect to the SQL Server on the computer with an Intellect Server installation.
b. Ensure SQL Server authentication through the base sa account.
c. Ensure uninterrupted connection of the SQL Server on the computer with a Client installation to the SQL
Server on the computer with the Intellect Server installation.

2. On the computer with an Intellect Server installation and the Access Manager module:
a. Configure SQL Server to allow remote connections.
b. Ensure SQL Server authentication through the base sa account.
c. Configure the Intellect Server connection to its database using the idb.exe utility. For this, you must
perform the following actions:
i. Run the utility from the Intellect Server installation directory.

= il

Select data source: Description:
- 5
|BBSIC data ﬂ | Data Link Properties @
1
[ Use i i
Provider | Cornection | Advanced | Al
Connection string: Move database || Configure I -

Specify the following to connect to SQL Server data;

|Provider=SQLOLEDB.1;Password="‘jPersistSecurity Info=True;User ID=saj| e
. Select or enter a server name:

Select dbi-file: 7 |_ITV-PC"-.SO LEXPRESS2008 - I Befresh ]
| C:\Program Files (x86)WrTennexT\intelect. dbi = 2 Errt_er information to log on to the server:
() Use Windows NT Integrated security 3
Select action @ Use a specific user name and password:
| Create backup co User pame: |sa
Additional tools Password: | ees

Update database | PR | kol B o0l L R

intellect - 5

Protocol () Attach a database file as a database name:

Test Connection

6
[ ok |[ cancel |[ Hep |

8

ii. In the utility interface, click the Configure button (1). The database connection window will open.
iii. In the Select or enter a server name field, type the name or IP address of the SQL server used to
for database management (2).

1 Note
* Please note that you must specify the explicit name or IP address of the machine on which
the database is installed. The format (local)\ SQLEXPRESS would be incorrect.


https://doc.axxonsoft.com/confluence/display/Int410en/Configuration+of+distributed+architecture
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Vi.

Vii.

viii.

. In the Enter the information to log on to the server settings section, check Use a specific user

name and password. In the User name field enter sa. In the Password field, enter the password
for the sa user. (3)

i Note
Note that accounts other than sa are not allowed.

Set the Allow saving password checkbox (4).

i Note
This step is also mandatory.

Set the Select the database on the server selector and choose intellect from the drop-down list
(5).

Click OK to save the connection settings (6). The parameters will be displayed in the Connection
string field in idb.exe (7).

Click OK in idb.exe to save the changes.

Setting up the proper operation of the Access Manager module in a distributed architecture is complete.
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